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Summary of Changes

v1.0.2, December 2012
Updates were made for the following new features and changes. Updates are marked 
with change bars in the margin.

• SL150 library support

• Miscellaneous corrections

v1.0.1, July 2012
Updates were made for the following new features and changes. Updates are marked 
with change bars in the margin.

• Lock out after five failed login attempts. 
See “User Account Lockout” on page 15. 

• New default screen refresh interval of 480 seconds. 
See “Session Management” on page 16. 

• Ability to change the automatic session timeout interval. 
See “Screen Interval Options” on page 16.

• System preferences for displaying removed drives and media. 
See “Removed Drives and Media Display Options” on page 17. 

• New table page number field on Exchanges, Cleaning Activities, and Notifications 
screens. 
See “List View Table Toolbar” on page 113 and “Display a Specific Table Page” 
on page 134. 

• Ability to clear previously applied filter criteria by blanking them out. 
See “Use the Filter Data Dialog Box to Change a Table Filter” on page 173. 

• New chapter addressing common questions about tape storage operations and 
health. 
See Chapter 8, “Using STA to Answer Tape Environment Questions” on page 211. 

v1.0.0, April 2012
Initial release. 
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Preface

This document provides information about Oracle’s StorageTek Tape Analytics (STA) 
user interface. It describes the layout of the screens and provides step-by-step 
instructions for modifying their display so you can tailor them to your needs. 

STA Documentation

Access to Oracle Support

Oracle customers have access to electronic support through My Oracle Support. For 
information, visit http://www.oracle.com/support/contact.html or visit 
http://www.oracle.com/accessibility/support.html if you are hearing impaired.

Document Title Description

StorageTek Tape Analytics 
Release Notes

Read this document before installing and using STA. It contains 
important release information, including known issues. 

StorageTek Tape Analytics 
Planning and Installation Guide

Use this book to plan for installation of STA, install the Linux 
platform, and install the STA software.

StorageTek Tape Analytics 
Configuration Guide

After installing the STA software, use this book to configure libraries, 
SNMP, email notification, services, identity management, and 
certificates.

StorageTek Tape Analytics 
Administration Reference Guide

Use this book to learn about STA administrative tasks, including 
server, services, and password administration. 

StorageTek Tape Analytics 
User Interface Guide

Use this book to learn about the STA user interface. It describes the 
layout of screens and provides step-by-step instructions for 
modifying their display so you can tailor them to your needs.

StorageTek Tape Analytics 
Data Reference Guide

Use this book to learn about using and interpreting the data 
displayed by STA. It provides definitions for all library, drive, and 
media data fields displayed by STA. It also provides reference 
information for all STA toolbars and data input fields.

StorageTek Tape Analytics 
Security Guide

Read this document for important STA security information, 
including requirements, recommendations, and general security 
principles.
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1

STA Introduction

Overview
Oracle’s StorageTek Tape Analytics (STA) is an intelligent monitoring application 
available exclusively for Oracle’s StorageTek Modular Tape Libraries. It simplifies 
tape storage management and allows you to make informed decisions about future 
tape storage investments based on the current health of your environment.

STA allows you to monitor globally dispersed libraries from a single, browser-based 
user interface. You can manage open systems and mainframe mixed-media, and 
mixed-drive environments across multiple library platforms. 

STA’s detailed performance trending analyses allow you to increase the utilization 
and performance of your tape investments. These analyses are based on a continually 
updated database of library operations. STA captures and retains data from your tape 
library environment and uses this data to calculate the health status of your library 
resources (drives and media). STA aggregates data according to a variety of criteria 
and displays it in tabular and graphical formats, allowing you to quickly assess 
environment activity, health, and capacity. 
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Supported Devices
STA supports the following devices. See “Pre-Installation Planning” in the STA 
Planning and Installation Guide for complete details about minimum firmware levels 
and other requirements. 

In general, the newer the drive model and the more up-to-date the drive and library 
firmware, the richer the data that STA receives and the more in-depth the analysis it 
can perform. For best results, it is recommended that you update your drive and 
library firmware to the most current versions. 

StorageTek Modular Tape Libraries 

• SL8500 standalone libraries, FRS 7.70 or later 

• SL8500 complexes, FRS 8.0 or later

• SL3000, FRS 3.60 or later 

• SL500, FRS 1466 or later 

• SL150, FRS 1.80 or later

Drive and Media Types 

• StorageTek T10000A, T10000B, and T10000C

• StorageTek 9840C and 9840D

• HP LTO-3, LTO-4, LTO-5, and LTO-6, full Automation/Drive Interface (ADI) 
support 

• IBM LTO-3 and LTO-4, full ADI support 

• IBM LTO-5 and LTO-6, basic support—Library/Drive Interface (LDI) mode—only 

Note – For LTO drives, the ADI protocol must be enabled on both 
the drives and the library for STA to receive rich data about these 
drives. LTO 2 and SDLT drives do not support ADI, and therefore 
STA receives only minimal data about them. 
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2

Getting Started

This section introduces you to basic login and screen display features of the STA user 
interface. The following topics are discussed: 

• “Requirements for the STA User Interface” on page 14

• “STA Login Sessions” on page 15

• “Session Management” on page 16

• “Screen Interval Options” on page 16

• “Removed Drives and Media Display Options” on page 17

• “Accessibility Options” on page 18

• “Confirmation Dialog Box Options” on page 18

• “Session Management Tasks” on page 19

• “Help” on page 34

• “Help Window Layout” on page 35

• “Help Toolbar” on page 36

• “Help Contents Tab” on page 37

• “Help Index Tab” on page 39

• “Help Search Tab” on page 40
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Requirements for the STA User Interface
Following are requirements for running the STA user interface on your computer. 
You should verify that your computer meets these requirements before you log in to 
STA.

Supported Operating 
Systems

• Windows XP, Vista, Windows 7

• Linux 5u5, 5u6

Screen Resolution • Minimum resolution is 1024 x 800.

• Recommended resolution is 1280 x 1024 or better. 

Supported Browsers Note – Other versions of Firefox and Internet 
Explorer are known to work with STA, but the 
following are the officially supported versions:

• Firefox 3.6

Note – Firefox 4.0 is not supported. 

• Internet Explorer 8.0 and 9.0

Browser Settings and 
Plugins

• JavaScript must be enabled.

• Flash 10 is required.

• Run all browsers in Native Mode. 

• In Internet Explorer 8.0, do not use Compatibility View, as follows:

• Select Tools > Compatibility View Settings and deselect the 
“Compatibility View” check boxes. 

• Select Tools >Internet Options and select the Advanced tab. 
Under Browsing, deselect the “Automatically recover from 
page layout errors with Compatibility View” check box. 

Browser Add-ons • Disable or remove third-party browser add-ons because they may 
interfere with the browser execution. 

• The STA user interface requires a minimum amount of space in the 
browser window. For best results, you should reduce, remove, or 
completely hide any toolbars that may reduce available space.

RTL Language Support • Support for RTL (right-to-left) languages, such as Arabic or 
Hebrew, is available only with Internet Explorer 8.0 or 9.0. 

Screen Reader Assistive 
Technology

• JAWS 11 is recommended.

• See “Accessibility Options” on page 18 for information about the 
accessibility features provided by STA. 
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STA Login Sessions 
Your STA administrator will provide you with a username and password for logging 
into STA. Once you are logged in, you have access to all STA screens and features. 
See “Log In to STA” on page 20 for instructions. 

Password Requirements

User passwords have the following format requirements:

• Must be 8–32 characters in length

• Must have at least one special character

• Must not have any of the following special characters:

< > & ? ( ) { } * ‘

User Account Lockout

After five unsuccessful login attempts within a five-minute period, you will be locked 
out of your user account for 30 minutes. For security reasons, your account cannot be 
reset during the lockout period, even by the STA administrator, so you must wait the 
full 30-minutes before attempting to log in again. 

Logging Out

When you are ready to finish a login session, it is recommended that you log out of 
STA rather than simply closing the browser window. Logging out releases the session 
memory on the STA server for other processes. If you simply close the browser 
window, the session memory is not freed until the defined session timeout period is 
exceeded, possibly impacting STA performance, especially if your session timeout 
period is long. See “Log Out of STA” on page 22 for instructions. 

Screen Navigation 

You should not use your browser’s Forward and Back (or Next and Previous) buttons 
for navigating through the STA screens. The use of these buttons could produce 
unpredictable results, as the data you see may be stale or out of sync with the data on 
the STA server. To navigate, you should always use the methods provided by STA: 
the Navigation Bar and text links. 

See Chapter 3, “User Interface Basics” on page 41 for complete details about STA 
screen navigation. 
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Session Management 
STA provides various options for managing your login sessions and modifying the 
STA user interface display. Because these modifications are made on a username 
basis, different users can modify the settings to their own needs. The following 
options are provided:

• “Screen Interval Options”, below 

• “Removed Drives and Media Display Options” on page 17

• “Accessibility Options” on page 18

• “Confirmation Dialog Box Options” on page 18

Screen Interval Options

You can modify both the screen refresh and automatic timeout intervals for your 
username. 

Screen Refresh Interval

The STA screen display is refreshed automatically to display new data that may be 
available. The default refresh rate is every 480 seconds (8 minutes). You can 
optionally change the refresh rate for your username. See “Modify the Screen Refresh 
Interval” on page 26 for details. 

Automatic Timeout Interval

The default session timeout is 30 minutes. You can optionally change the timeout 
period for your username to any period from 10 minutes to 60 days. See “Modify the 
Login Session Timeout Period” on page 28 for details.

Note – Increasing the session timeout is likely to increase STA 
server memory utilization, with possible impact on STA 
performance. See “Logging Out” on page 15 for additional 
information. 

If your login session is idle for the defined amount of time, your session will be 
ended automatically. Two minutes prior to the expiration time, the following dialog 
box appears. Click OK within the two-minute period to keep your session active. 

If you do not click OK within the two-minute period, your session is ended, and the 
following dialog box appears. 
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When you click OK, you are re-directed to the Login screen so you can log in again. 

Removed Drives and Media Display Options

By default, removed drives and media are not included on their respective Overview 
and Analysis screens. However, you can selectively turn on the display of either 
removed drives, removed media, or both. Your selections take effect immediately, so 
depending on your needs, you can selectively show or hide removed drives and 
media throughout your login session. See “Modify Removed Drives and Media 
Display Settings” on page 24 for instructions on how to change the settings.

TABLE 2-1 summarizes the effects of selecting or deselecting each option. See 
“Understanding STA Analytics” in the STA Data Reference Guide for a more detailed 
discussion of the effects. 

TABLE 2-1  Removed Drives and Media Display Settings

Option Selected Deselected

Show Removed 
Drives

Removed drives are listed on the 
Drives – Overview screen.

Removed drives are not listed on the 
Drives – Overview screen.

Aggregated data for removed drives 
are included on the Drives – Analysis 
screen. 

Aggregated data for removed drives 
are not included on the Drives – 
Analysis screen.

On all screens, drive serial numbers of 
removed drives are active links to the 
Drives – Overview, Detail View 
screen. 

On all screens, drive serial numbers of 
removed drives are dimmed and are 
not active links.

Show Removed 
Media

Removed media are listed on the 
Media – Overview screen.

Removed media are not listed on the 
Media – Overview screen.

Aggregated data for removed media 
are included on the Media – Analysis 
screen.

Aggregated data for removed media 
are not included on the Media – 
Analysis screen.

On all other screens, volume serial 
numbers (VSNs or volsers) of 
removed media are active links to the 
Media – Overview, Detail View 
screen.

On all other screens, volsers of 
removed media are dimmed and are 
not active links.
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Accessibility Options

The STA user interface provides accessibility options for users with low vision, 
blindness, color blindness, or other visual impairments. See “Modify Accessibility 
Preferences” on page 30 for instructions on enabling the options. The following 
options are available:

• Screen reader mode – Enables screen reader mode for users with low vision, 
blindness, color blindness, or other visual impairments. This mode causes the 
screen display to be optimized for use with screen readers such as JAWS. It also 
allows you to perform all screen actions with the keyboard instead of a mouse, 
and alternate text is provided for all screen icons, buttons, and graphic images

• High contrast mode – Causes STA screens to be compatible with high-contrast 
features provided by your browser. For best results, you may also want to enable 
large fonts mode, described below.

This mode is designed to be used in conjunction with your browser’s high-
contrast capabilities (see your browser’s documentation for details). You should 
disable this mode if you are not using these capabilities in your browser. 

• Large fonts mode – Causes STA screens to be compatible with larger font sizes 
and zoom capabilities provided by your browser. For best results, you may also 
want to enable high-contrast mode, described above. 

This mode is designed to be used with larger fonts or zoom capabilities in your 
browser (see your browser’s documentation for details). You should disable this 
mode if you are not using these capabilities in your browser. 

In addition, tooltips provide text detail for all graphs and text items. See “Tooltips” 
on page 46 and “Types of Graphs” on page 65 for details. 

Confirmation Dialog Box Options

By default, confirmation dialog boxes are displayed for the following activities:

• Synchronizing the date range for all graphs on a screen; see “Synchronize a Date 
Range Across All Graphs” on page 97. 

• Overwriting a custom or pre-defined template; see “Modify a Template” 
on page 203. 

• Deleting a custom or pre-defined template; see “Delete a Template” on page 206. 

You can selectively turn off the display of any of these dialog boxes. Your selections 
take effect immediately. See “Modify Confirmation Dialog Box Preferences” 
on page 32 for instructions.
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Session Management Tasks

Task Page

Log In to STA 20

Log Out of STA 22

Display STA Software Version Information 23

Modify Removed Drives and Media Display Settings 24

Modify the Screen Refresh Interval 26

Modify the Login Session Timeout Period 28

Modify Accessibility Preferences 30

Modify Confirmation Dialog Box Preferences 32
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▼ Log In to STA

Use this procedure to start an STA session. Before using this procedure, you must 
verify that your computer and browser are configured correctly. See “Requirements 
for the STA User Interface” on page 14 for details.

In addition, you must get the following information from your STA administrator:

• URL of the STA server 

• Your username and password

1. Start a supported Web browser on your computer. 

2. In the Location Bar or Address field, enter the URL of the STA server. The URL 
uses one of the following formats:

http://local_host_name:port_number/STA 
https://local_host_name:port_number/STA 

where local_host_name and port_number are the name and port number of the STA 
server given to you by your STA administrator. Typically, STA runs on port 7021. 

The Login screen appears. 

3. Enter the username and password you have been assigned, and then click 
Login.
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Depending on the preference settings for your username, the Accessibility 
Settings dialog box may appear. 

4. Complete the Accessibility Settings dialog box, if applicable, and then click 
OK. See “Modify Accessibility Preferences” on page 30 for details on 
completing this dialog box.

The Dashboard appears. 
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▼ Log Out of STA

Use this procedure to terminate your STA session. You can terminate your session at 
any time. 

Note – It is recommended that you log out of STA rather than 
simply closing the browser window. Logging out releases the 
session memory on the STA server for other processes. It is 
especially important to log out if your defined login session 
timeout period is long. See “Automatic Timeout Interval” 
on page 16 for related information. 

1. From any STA screen, click Logout in the Main Toolbar. 

Your login session is terminated and the Logged Out dialog box appears.

2. Click Go to Login. 

The Login screen appears. See “Log In to STA” on page 20 for instructions on 
logging in. 
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▼Display STA Software Version Information

Use this procedure to display version information about the STA application and 
supporting software. This information is useful whenever you contact your Oracle 
support representative. 

1. Click About in the lower-right corner of the STA screen.

The version information dialog box is displayed.

2. Click OK to dismiss the dialog box. 
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▼Modify Removed Drives and Media Display Settings

Use this procedure to customize the removed drives and media display settings for 
your username in this and future login sessions. These settings control how removed 
drives and media are displayed by the STA user interface. See “Removed Drives and 
Media Display Options” on page 17 for details.

1. Select Preferences > Data Handling from the Main Toolbar.

The Data Handling dialog box appears. 

2. Select the appropriate check boxes to enable the display of removed drives and/
or media. 
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3. Verify your selections and then click OK. 

The settings take effect immediately. They remain in effect for this and future 
login sessions, until you change them again using this procedure. 
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▼Modify the Screen Refresh Interval

Use this procedure to set the screen display refresh rate for your username in this and 
future login sessions. STA screens will be updated to display new data at the 
frequency you specify. The default is 480 seconds. See “Screen Refresh Interval” 
on page 16 for details.

1. Select Preferences > Refresh Settings from the Main Toolbar.

The Refresh Settings dialog box appears. 

2. In the “Refresh interval in seconds” field, enter the new refresh rate want to 
assign, and then click OK. 
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The settings take effect immediately. They remain in effect for this and future 
login sessions, until you change them again using this procedure. 
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▼Modify the Login Session Timeout Period 

Use this procedure to set the timeout period for your username in this and future 
login sessions. If your login session is idle for longer than this amount of time, your 
session will be ended. The default is 30 minutes. See “Automatic Timeout Interval” 
on page 16 for details.

1. Select Preferences > Refresh Settings from the Main Toolbar.

The Refresh Settings dialog box appears. 

2. In the “Session timeout in minutes” field, enter the timeout period you want to 
assign, and then click OK. 
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The settings take effect immediately. They remain in effect for future login 
sessions, until you change them again using this procedure. 
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▼Modify Accessibility Preferences

Use this procedure to customize the accessibility settings for your username in this 
and future login sessions. See “Accessibility Options” on page 18 for details.

1. Select Preferences > Accessibility from the Main Toolbar. 

Note – If the “Do not show these options again” check box is not 
selected, then this screen appears automatically whenever you log 
in to STA. 

The Accessibility Settings dialog box appears. 

2. Select the appropriate check boxes to enable the accessibility modes you want 
to use. Options are:

• Screen Reader – Causes the screen display to be optimized for use with screen 
readers such as JAWS. It also allows you to perform all screen actions with the 
keyboard instead of a mouse.

• High Contrast – Causes STA screens to be compatible with high-contrast 
features provided by your browser. For best results, you may also want to 
enable large fonts mode, described below.

• Large fonts – Causes STA screens to be compatible with larger font sizes and 
zoom capabilities provided by your browser. For best results, you may also 
want to enable high-contrast mode, described above. 
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• Do not show these options again – Indicates that you do not want this dialog 
box to be displayed automatically when you log in. If you apply this option, 
this dialog box will be skipped for all future times that you log in to STA. You 
can use this procedure to reset this option at any time. 

3. Verify your selections and then click OK. 

The STA screen display is immediately modified according to your selections. 
These settings remain in effect for future login sessions, until you change them 
again using this procedure. 
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▼Modify Confirmation Dialog Box Preferences

Use this procedure to customize the display of selected confirmation dialog boxes for 
your username in this and future login sessions. See “Confirmation Dialog Box 
Options” on page 18 for details. 

1. Select Preferences > Confirmations from the Main Toolbar. 

The Confirmations dialog box appears. 

2. For each option listed, select the check box to display the dialog box or deselect 
the check box to suppress the dialog box. Options are:

• Graph Time Sync – Selecting this check box indicates you want a confirmation 
dialog box to appear before you synchronize all graphs on a screen to the same 
date range. 

Deselecting this check box indicates you want to suppress the confirmation 
dialog box. Graphs will be synchronized as soon as you click Synchronize 
Date Range in the Graph Pane Toolbar. 

• Template Overwrite – Selecting this check box indicates you want a 
confirmation dialog box to appear before you save changes to an existing 
template. 

Clearing this box indicates you want to suppress the confirmation dialog box. 
Existing templates will be overwritten as soon as you click Save in the Save 
Template dialog box.

• Template Delete – Selecting this check box indicates you want a confirmation 
dialog box to appear before you delete an existing template.
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Clearing this box indicates you want to suppress the confirmation dialog box. 
Templates will be deleted as soon as you click Delete in the Delete Template 
dialog box. 

3. Verify your selections and then click OK. 

The settings take effect immediately. They remain in effect for future login 
sessions, until you change them again using this procedure. 
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Help
STA provides context-sensitive Help for all screens. Help buttons are located on the 
following toolbars:

• Main Toolbar 

• Template Toolbar

• Graphics Area Toolbar

• List View Table Toolbar (Overview screens only)

• Pivot Table Toolbar (Analysis screens only) 

• Dialog boxes
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Help Window Layout

Name Description

A Title Displays the title of the help system. 

B Helpset Quick 
Search

Allows you to perform a quick search throughout the helpset. 

C Help Toolbar Provides direct access to commands for interacting with the helpset. See 
“Help Toolbar” on page 36 for details. 

D Topic Quick Search Allows you to perform a quick search within the currently displayed 
topic. 

E Help Navigation Bar Provides three navigation tabs: Contents, Index, and Search. See the 
following topics for details:

• “Help Contents Tab” on page 37 

• “Help Index Tab” on page 39 

• “Help Search Tab” on page 40 

F Browse Buttons Allows you to browse sequentially through the help topics, forward and 
backward. 

G Topic Breadcrumbs Shows the current topic within the topic hierarchy. Click a parent 
heading to display that topic. 

H Topic Area Displays the contents of the help topic. 
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Help Toolbar

The Help Toolbar provides direct access to frequently used commands for displaying 
and using the help system.

Icon Name Description

View menu Provides the following selections: 

• Maximize Reading Pane – Toggles the expansion or collapse 
of the navigator pane.

• Restore Default Window Layout – Rearranges the panes 
according to the default layout.

• Contents – Expands the Contents tab in the Help Navigation 
Bar.

• Index – Expands the Index tab in the Help Navigation Bar.

• Search – Expands the Search tab in the Help Navigation Bar. 

• Show permanent link for this topic page – Allows you to 
save a link to the current topic in your browser bookmarks.

Go back/forward 
one page 

Allows you to retrace your steps backward and forward through 
previously displayed topics. 

Print this topic 
page

Opens your computer’s print dialog box so you can print the 
current topic. 

Email this topic 
page

Opens your computer’s default email application so you can 
email the link to the current topic. 

Link to this topic 
page

Allows you to save the link to the current topic in your browser 
bookmarks. 
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Help Contents Tab

The Contents tab displays the table of contents for the helpset. Topics are listed in a 
hierarchical tree, with higher-level headings shown as folders. You can expand or 
collapse folders to list or hide the headings within. Click a heading to display the 
topic in the Topic Area. 

Context Menu

Right-click within the Contents Tab to bring up the Context Menu. 

Menu Selection Action

Print This Page Opens your computer’s print dialog box so you can print the 
current topic. Also available through the Help Toolbar.

Email This Page Opens your computer’s default email application so you can 
email the link to this topic. Also available through the Help 
Toolbar. 

Link to This Page Allows you save a link to the current topic in your browser 
bookmarks. Also available through the Help Toolbar.
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Expand Expands the selected heading. 

Collapse Collapses the table of contents to hide the headings within the 
selected heading.

Expand All Below Expands the selected heading and all sub-headings within it. 

Collapse All Below Collapses the selected heading and all sub-headings within it. 

Show As Top Displays the current heading at the top of the Contents tab.

Menu Selection Action
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Help Index Tab

The Index tab displays a sorted index of keywords in a two-level hierarchy. A 
keyword can be associated with multiple topics. 

Name Description

A Jump to keyword Enter one or more words in the text field. As you type, the first keyword 
in the list that matches the typed letters is selected. As more letters are 
typed, a more accurate selection is made. 

B Keyword list Two-level list of keywords, sorted alphabetically. Select a keyword to 
display the associated topic in the Topic list. 

C Expand/Collapse 
Pane

Click to expand or collapse the Topic list. 

D Topic list List of keywords. Click a keyword link to display the associated topic in 
the Topic Area. Click on a column heading (Topic or Source) to sort by 
that column. 
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Help Search Tab 

The Search tab allows you to construct a full-text query that searches throughout the 
helpset. 

Name Description

A Search text Enter one or more words in the text field. As you type, the first keyword 
in the list that matches the typed letters is selected. As more letters are 
typed, a more accurate selection is made. 

B Selection criteria Allows you to specify selection criteria for the search. 

C Expand/Collapse 
Pane

Click to expand or collapse the Topic list. 

D Topic list List of search results. Includes the topic title, score, and source of each. 
Click a topic link to display it in the Topic Area. 

The Score column indicates the ranking of the topics according to how 
well they match the search criteria. By default, all topics are sorted by 
Score. Click on a column heading (Topic Title, Score, or Source) to sort by 
that column. 
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3

User Interface Basics

This section describes the layout and navigation of the STA screens. The following 
topics are discussed:

• “General Screen Layout” on page 42

• “Main Toolbar” on page 43

• “Main Window” on page 44

• “Screen Display Features” on page 45

• “Cursor Shapes” on page 45

• “Tooltips” on page 46

• “Object Selection” on page 46

• “Time Zone Adjustments” on page 48

• “Navigation Methods” on page 49

• “Navigation Bar” on page 49

• “Text Link Navigation” on page 49

• “Screen Arrangement Tasks” on page 51

• “Navigation Tasks” on page 56
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General Screen Layout
All STA screens follow the same general structure and layout. The main parts are 
illustrated and described below. 

Item Description

A Main Toolbar Provides direct access to frequently used screen-independent commands. See 
“Main Toolbar” on page 43 for details. 

B Navigation 
Bar

Primary navigation tool for STA. Provides direct access to all STA screens. See 
“Navigation Bar” on page 49 for details.

C Screen Title Name of the screen. Corresponds to the screen link in the Navigation Bar. 

D Templates 
Toolbar

Provides access to the most frequently used commands for using templates. See 
Chapter 7, “Templates”, on page 189 for details. 

E Main Window Main focus of the screen, where the STA content is displayed. See “Main 
Window” on page 44 for details. 

F Collapse Pane 
icon

Indicates that the pane can be collapsed or resized, either vertically or 
horizontally. See “Collapse and Restore the Graphics Area” on page 54 for 
details. 
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Main Toolbar

The Main Toolbar is located at the top of all STA screens. It provides direct access to 
frequently used screen-independent commands. 

 

G Resize control 
bar

Indicates that the pane can be resized, either vertically or horizontally. Appears 
when you move the mouse over the space between two resizable screen areas. 
See “Resize the Graphics and Table Areas” on page 55 for details. 

H Scrollbars Allow you to scroll vertically or horizontally to display more data. Appear 
dynamically whenever the screen area is not large enough to display all the 
data at once. 

I About Displays detailed software version information. See “Display STA Software 
Version Information” on page 23 for details. 

Item Description

Icon Name Description

Preferences Menu provides options for you to modify display settings for 
STA screens and templates. 

Related Topic: “Session Management”

Help Link displays help for the current screen. 

Related Topic: “Help” 

Username Username Displays the username currently logged in. 

Related Task: “Log In to STA” 

Logout Link logs you out of STA. 

Related Task: “Log Out of STA”

Idle

Loading

Progress 
Indicator

Indicates whether the screen has finished or is in the process of 
loading. 
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Main Window

STA provides the following types of screens: 

• Dashboard

• Overview

• Analysis

In Overview and Analysis screens, the Main Window is divided into a Graphics Area 
at the top and a Table Area at the bottom. The border between the two areas is 
marked by the Collapse Pane icon and the Resize control bar, as shown in the 
following example. 
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Screen Display Features

Cursor Shapes

The cursor changes shape as you move the mouse over different areas of the STA 
screen. Understanding the meaning of the different cursors assists you in using the 
STA user interface. 

Cursor Name Description

Pointer This is the default cursor. Click to select active buttons or data table rows. 

Text pointer Appears when you move the mouse over a text area that is not an active 
link, such as the Screen Title. 

Link select Appears when you move the mouse over a text area that is an active link, 
such as a screen name in the Navigation Bar or an aggregate count in a 
pivot table. Click to select the link. 

Resize object Double-headed arrow which can be vertical, horizontal, or diagonal, 
depending on the axis that will be resized. Displays when you move the 
mouse over the edge of a resizable screen area or graph. Click and drag to 
resize the object. 

Move object Appears when you move the mouse over a table column heading or top 
border of a graph. Click and drag to move the object to a different 
location within the table or pane. In pivot tables, click and drag, to move 
the pivot table layer. 

Hourglass Appears when the STA screen is loading or fetching data. 

The following cursors appear in tables only.

Select row Appears when you move the mouse over a row heading. Click to select 
the row. 

Select column Appears when you move the mouse over a column heading. Click to 
select the column. 
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Tooltips

A tooltip is a small popup window that displays descriptive text. Tooltips are 
available for most STA screen icons, buttons, graphic images, and text items. Move 
the mouse over an item to display the tooltip. 

Object Selection

You can select most STA objects—items in dialog box lists, table columns, and table 
rows, for example. In addition, the STA interface supports multi-select for many 
object types. The STA documentation identifies when multi-select is supported and 
when it is not. 

The following examples use the Reorder Columns dialog box, which appears when 
you select View > Reorder Columns from the List Table Toolbar. 

• Click an object to select it.

Select fixed 
column

Appears when you move the mouse over the heading of a fixed column. 
Click to select the column. 

Resize row Appears when you move the mouse over the border between rows. Click 
and drag to resize the row. 

Resize column Appears when you move the mouse over the border between columns. 
Click and drag to resize the column. 

Cursor Name Description
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Multi-select

• Shift-click to select a range of objects.

• Ctrl-click to select multiple non-contiguous objects. 

Deselect

• Ctrl-click an already selected object to deselect it. 
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Time Zone Adjustments

Dates and times of events displayed by the STA user interface are automatically 
adjusted to the user’s local time zone. For example, an exchange with a start time of 
02:43 on a library in San Francisco will show a start time of 08:43 for an STA user in 
Brasilia, and 17:43 for a user in Jakarta. 
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Navigation Methods
Note – You should not use your browser’s Forward and Back (or 
Next and Previous) buttons for navigating through the STA 
screens. The use of these buttons could produce unpredictable 
results, as the data you see may be stale or out of sync with the 
data on the STA server. To navigate, you should always use the 
methods provided by STA: the Navigation Bar and text links, 
described below. 

Navigation Bar

The Navigation Bar is located on the left side of the STA screen. It consists of a series 
of vertical tabs that expand and collapse according to your selections. The vertical 
tabs provide a visual map of the STA screen hierarchy. The number of screens listed 
under each tab varies. You can expand only one tab at a time. 

The Navigation Bar serves as the primary means of navigation, and all STA screens 
are accessible through it. Additional navigation options are offered through text links. 
See “Text Link Navigation”, below, for details. 

Text Link Navigation

The Navigation Bar is the primary navigation tool for STA, allowing you direct access 
to all STA screens (see “Navigation Bar”, above, for details). Text links provide an 
additional means of navigation, especially for drilling down to detailed information 
about resources. 

The following types of text links are available:

• “Resource ID Links” on page 50

• “Aggregate Count Links” on page 50

When you click a text link, you are taken to a screen displaying additional detail for 
the item(s), and the Navigation Bar updates to reflect your current location within the 
screen hierarchy. 
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In addition, by clicking a link you apply filter criteria to the resulting screen, and 
these criteria remain active as you navigate to other screens. This is an important 
point in understanding the full power of STA. See Chapter 6, “Filtering Table Data”  
on page 163 for full details. 

Resource ID Links

Resource ID links appear in List View Tables and Detail View screens. For example, 
the following identifiers are always active links:

• Media IDs: Usually Volume Serial Number (VSN or volser)

• Drive IDs: Usually Drive World Wide Node Name (WWNN) or Drive Serial 
Number 

• Exchange IDs: Usually Exchange Start 

Clicking a resource ID link takes you to the corresponding Detail View screen, which 
provides complete details for that resource. The Detail View screen may, in turn, 
provide links for related resources; you can click any of them to display detail about 
these resources. 

Note – In most cases, resource IDs are unique, but in some cases 
they may not be, such as duplicate volsers in a library or library 
complex. 

Aggregate Count Links

The cells within pivot tables contain aggregate counts of resources or events that 
meet specific criteria (see “Pivot Tables” on page 115 for details). 

Clicking an aggregate count takes you to the corresponding Overview screen, which 
provides additional detail for the resources included in the count. If the aggregate 
count is “1”, only one resource is displayed on the Overview screen. If the aggregate 
count is “0”, clicking the link displays the message: “There is no data to display.” 

Note – Aggregate count links also apply filter criteria to the data 
displayed in the table. See “Filtering Using Aggregate Count 
Links” on page 169 for details. 
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Screen Arrangement Tasks

Task Page

Collapse and Restore the Navigation Bar 52

Resize the Navigation Bar 53

Collapse and Restore the Graphics Area 54

Resize the Graphics and Table Areas 55
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▼Collapse and Restore the Navigation Bar

Use this procedure to hide the Navigation Bar and then restore it. 

1. Click the Collapse Pane icon in the space between the Navigation Bar and the 
Main Window. 

The Navigation Bar is collapsed, and the Main Window is expanded horizontally 
across the entire screen. 

2. To restore the Navigation Bar to its original width, click the Restore Pane icon 
on the left side of the window. 
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▼Resize the Navigation Bar

Use this procedure to resize the Navigation Bar and Main Window relative to one 
another.

1. Move the mouse over the space between the Navigation Bar and the Main 
Window, until the vertical Resize control bar and Resize object cursor appear. 

2. Click and drag the control bar until the Navigation Bar and Main Window are 
the sizes you want, and then release the control bar.
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▼Collapse and Restore the Graphics Area

Use this procedure to hide the Graphics Area and then restore it. Collapsing the 
Graphics Area provides more space in the Main Window for you to view table data. 

1. Click the Collapse Pane icon in the space between the Graphics and Table 
Areas. 

The Graphics Area is hidden, and the Table Area expands vertically over the 
entire Main Window.

2. To restore the Graphics Area to its original size, click the Restore Pane icon at 
the top of the Main Window. 
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▼Resize the Graphics and Table Areas

Use this procedure to resize the Graphics and Table Areas relative to one another. 

1. Move the mouse over the space between the Graphics and Table Areas until the 
Resize control bar and Resize object cursor appear.

2. Click and drag the control bar until the two areas are the sizes you want, and 
then release the mouse.
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Navigation Tasks

Task Page

Use the Navigation Bar to Access Screens 57

Use Resource ID Links to Navigate 58

Use Aggregate Count Links to Navigate 61
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▼Use the Navigation Bar to Access Screens

Use this procedure to display screens through the Navigation Bar. 

1. Click a collapsed tab in the Navigation Bar. 

The tab is expanded, displaying links to all the screens in the tab. 

At the same time, the first screen listed under the tab is automatically displayed in 
the Main Window. The screen title, at the top left of the Main Window (Drives –
Overview in this example) corresponds to your selection in the Navigation Bar. 

2. You can navigate to other screens by doing either of the following:

• Click a screen link within the currently expanded tab to display that screen.
 

• Click any collapsed tab to expand it and display links to its screens. 
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▼Use Resource ID Links to Navigate

This procedure is an example of using resource ID links to display detail about an 
individual drive and other resources related to it.

1. In the Navigation Bar, click Drives to display the Drives – Overview screen.

The Drive Serial Number column displays text links for all drives. 

2. Click one of the drive links. 

You are taken to the Drives – Overview, Detail View screen, which displays full 
detail for the selected drive.
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• A – Detail View header identifies the drive displayed. 

• B – Related resource ID links appear on the screen. 

3. Click Volume Serial Number link.

You are taken to the Media – Overview, Detail View screen, which displays full 
detail for the selected media record. 



Navigation Tasks

60  STA User Interface Guide December 2012 

 

• A – Screen title identifies the current screen.

• B – Detail View header identifies the media record displayed.

• C– Additional resource ID links appear on the screen. You can click any of 
these links to continue navigation.
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▼Use Aggregate Count Links to Navigate

This procedure is an example of how to use aggregate count links to drill down to 
additional detail about a group of drives included in an aggregate count.

1. In the Navigation Bar, click the Drives tab and then the Analysis link to display 
the Drives – Analysis screen.

The screen includes a pivot table. In this example, the aggregate count “3” in the 
highlighted cell represents three StorageTek drives in library “1”, within complex 
“A-SL8500”, that all have a health indicator of “MONITOR”. 

2. Click the highlighted link. 

You are taken to the Drives – Overview screen, which displays additional detail 
for the three drives. 
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• A – Screen title identifies the current screen.

• B – Table filter description is updated to reflect the filter criteria represented by 
the aggregate count on the Drives – Analysis screen. See “Filtering Overview” 
on page 164 for details on the table filter description. 

• C – The three drives included in the aggregate count are shown in the data 
table. 

3. Click any of the text links in the Drive WWNN column to display complete 
details for an individual drive. At this point, see “Use Resource ID Links to 
Navigate”, starting with Step 2 on page 58, for sample instructions. 



December 2012 Graph Displays  63

 

4

Graph Displays

Graphs appear in the Main Window of the following types of screens:

• Dashboard

• Overview

• Analysis

This section describes the types of graphs available on Overview and Analysis 
screens and provides instructions for modifying their appearance and the data they 
display. The following topics are discussed:

• “Areas of the Main Window” on page 64

• “Types of Graphs” on page 65

• “Graphs on Overview Screens” on page 72

• “Graphics Area Layout – Overview Screens” on page 75

• “Graphics Area Toolbar for Overview Screens” on page 76

• “Graph Pane Toolbar for Overview Screens” on page 76

• “Graphs on Analysis Screens” on page 78

• “Graphics Area Layout – Analysis Screens” on page 79

• “Graphics Area Toolbar for Analysis Screens” on page 80

• “Graph Pane Toolbar for Analysis Screens” on page 80

• “Graph Display Tasks” on page 81

• “Data Graphing Tasks” on page 91
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Areas of the Main Window
All STA Overview and Analysis screens follow the same general structure and layout. 
The Main Window is divided into a Graphics Area at the top, and a Table Area at the 
bottom. The border between the two areas is marked by the Collapse Pane icon, 
which is visible at all times, and the Resize control bar, which appears when you 
move the mouse over the space between the two areas. 

STA has two types of graphics screens: Overview and Analysis. This section describes 
graph characteristics and tasks that are shared by both screen types. See the following 
sections for characteristics unique to each type.

• “Graphs on Overview Screens” on page 72

• “Graphs on Analysis Screens” on page 78
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Types of Graphs
This section describes the types of graphs used in STA. It also describes actions you 
can perform to get the most information from the graphs. 

• “Line Graphs” on page 66

• “Area Charts” on page 67

• “Bar Charts” on page 68

• “Pie Charts” on page 70
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Line Graphs

Line graphs are used to compare actual values for one or more resources over a 
period of time. Each line represents a resource (drive or media) or other category of 
data. Time is always shown on the horizontal axis. Each point on the line represents 
an actual value at a point in time. There must be at least two data points available for 
a line graph; if there is only one data point, the graph will display as a bar chart. 

Note – The default date range for most STA line graphs (libraries, 
complexes, drives, and media) is the last 30 days. For exchanges, 
the default is one day—the current date. 

User Action Description

Display detailed values Move the mouse over a point in time on a line to display the specific 
value in a tooltip. Other lines on the graph are dimmed. 

Highlight values Move the mouse over an area of the legend to highlight that line on the 
graph. All other lines remain on the graph but are dimmed. 

Hide values Clear a legend entry to remove the line from the graph. In this example, 
the “Written” box on the legend is empty to indicate that the line is 
hidden on the graph. 

Restore hidden values Select a hidden legend entry (“Written”, in this example) to restore the 
line to the graph. 
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Area Charts

Area charts are used to compare percentage values for two or more resources over a 
period of time. An area chart is similar to a line graph, but in addition, the area under 
the line is filled in with a color or pattern. Each line represents a resource (drive or 
media) or other category of data, and the size of the area under the line represents the 
resource’s percentage of the total. Time is always displayed on the horizontal axis. 
Each point on the line represents an actual data value at a point in time. 

Note – The default date range for most STA area charts (libraries, 
complexes, drives, and media) is the last 30 days. For exchanges, 
the default is one day—the current date. 

User Action Description

Display detailed values Move the mouse over a point in time on a line to display the specific 
value in a tooltip. Other sections on the graph are dimmed. 

Highlight values Move the mouse over an area of the legend to highlight that section on 
the graph. All other sections remain on the graph but are dimmed. 



Types of Graphs

68  STA User Interface Guide December 2012 

 

Bar Charts 

Bar charts are used to display actual values for one or more resources at a point in 
time. Each bar represents a resource (drive or media) or other category of data, and 
the size of the bar represents the resource’s actual value. 

Action Description

Display detailed values Move the mouse over a bar to display the specific value in a tooltip. 
Other bars on the graph are dimmed. 

Link to a detail screen Note – This action is available from the Dashboard 
only. 

Click an area of the bar to link to the detail screen for that resource type; 
in this example, the link is to the Drives – Overview screen. The List 
View table on the screen indicates that a filter has been applied: 
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Highlight values Move the mouse over an area of the legend to highlight that entry in the 
graph. All other entries remain on the graph but are dimmed. 

Hide values Clear a legend key to remove that bar from the graph. In this example, the 
“Monitor” key on the legend is empty to indicate that the bar is hidden 
on the graph. 

Restore hidden values Select an empty legend key (“Monitor”, in this example) to restore the bar 
to the graph. 
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Pie Charts

Pie charts are used to compare percentage values for two or more resources at a point 
in time. Each section of the pie represents a resource (drive or media) or other 
category of data, and the size of the section represents the resource’s percentage of 
the total. To be meaningful, pie charts require graphing at least two resources, as only 
one resource will take up all of the pie. 

Action Description

Display detailed values Move the mouse over a section of the pie to display the percentage value 
in a tooltip. Other sections of the pie are dimmed. 

Link to an Overview 
screen

Note – This action is available on the Dashboard only. 

Click a pie section to link to the Overview screen for that resource type; in 
this example, the link is to the Drives – Overview screen. The List View 
table on the screen indicates that a filter has been applied:
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Highlight values Move the mouse over an area of the legend to highlight that entry in the 
pie chart. All other entries remain on the chart but are dimmed. 

Hide values Clear a legend key to remove that section from the pie chart. In this 
example, the “HP LTO-4” key on the legend is empty to indicate that the 
section is hidden on the chart. 

Restore hidden values Select an empty legend key (“HP LTO-4”, in this example) to restore the 
section to the chart. 

Action Description
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Graphs on Overview Screens
The Graphics Area of Overview screens consists of the Graphics Area Toolbar and 
one or more graph panes. Each graph pane also has a Graph Pane Toolbar. When 
multiple graph panes are displayed, they are tiled, up to three per row. You can 
display up to 15 graph panes at a time. 

You can modify the data displayed on individual graph panes through any of the 
following actions:

• Change the displayed attribute; see “Graphed Attribute” below for details. 

• Change the displayed date range; see “Date Range” below for details.

• Switch between real and percentage values; see “Real and Percentage Values” 
below for details.

• Add individual resources to the graph for direct comparison; see “Individual 
Resources” on page 73 for details.

Graphed Attribute

Each graph pane displays values for exactly one drive or media attribute. You can 
change the displayed attribute by clicking the Change Graphed Attribute icon on the 
Graph Pane Toolbar and then selecting any of the available attributes for that 
resource type. 

See “Change the Graphed Attribute” on page 92 for detailed instructions. 

Date Range 

By default, most graph panes display values for the previous 30 days. This is a rolling 
time period which is updated daily. The exception to this is the graph panes on the 
Libraries – Exchanges screen, which display values for the current date only. 

You can change the date range by clicking the Choose Date Range icon on the Graph 
Pane Toolbar. You can then specify new start and ending dates for the range or a 
point in time (one day). Date ranges longer than one day are displayed as line 
graphs. Point-in-time graphs are displayed as bar charts. See “Change the Date 
Range” on page 94 for detailed instructions. 

Once you have specified a new date range for an individual graph, you can apply 
that range to all graphs on the screen by clicking the Synchronize Date Range icon. 
See “Synchronize a Date Range Across All Graphs” on page 97 for detailed 
instructions. 

Real and Percentage Values

By default, the graph panes display actual data values. You can optionally switch to a 
percentage display, which shows individual resource values as a percentage of the 
whole. Actual values are displayed as a line graph, and percentage values are 
displayed as an area graph.

You can switch between actual and percentage value displays by selecting the Show 
Percentages icon on the Graph Pane Toolbar. 
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See “Switch Between Actual and Percentage Values – Overview Screens” on page 101 
for detailed instructions. 

Units of Measure

Units of measure are identified on the horizontal and vertical axes of each graph 
pane. On line and area graphs, which show values over time, time is always shown 
on the horizontal axis, and the attribute values are shown on the vertical axis. The 
scale of both axes automatically adjust to provide a useful amount of detail for the 
values included in the graph. 

If the graphed attribute includes a unit of measure, such as MB Read, then the total 
value of a given data point is the product of the unit of measure included in the 
attribute multiplied by the unit of measure of the vertical axis. For example, the 
graph panes shown below use different units of measure on their vertical axes. 

• In the MB Read graph, the highlighted data point indicates a value of 88.59K. 
Because the vertical axis is measured in megabytes, the value of the data point is 
actually 88.59K megabytes, or 88,590 MB. 

• In the Drive Dismounts graph, the highlighted data point indicates a value of 
2.440. Because there is no multiplier on the vertical axis, the value of the data 
point is actually 2.440. 

Individual Resources

When you first bring up an Overview screen, the graph panes display only the 
system average for their selected attribute. You can compare individual resources to 
each other and the system average by adding the resources to the graphs. You add 
individual resources by selecting them on the List View table, and then applying the 
selection to the graphs. The individual values are then highlighted on the graph, and 
the system average is ghosted. 
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You can change the displayed resources simply by selecting different ones and re-
applying the selection. If there is no data for a selected resource, no values will 
appear on the graph, but the resource will be added to the graph key to indicate that 
it has been selected. When you leave the Overview screen, the selections are cleared, 
so that when you return, the graph panes again display the system average only. 

To clear all resources from the graphs without exiting the screen, you can deselect all 
resources on the List View table, and then re-apply the selection to the graphs. 

See “Add Library Resources to Graphs” on page 99 for detailed instructions. 
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Graphics Area Layout – Overview Screens

Name Description

A Overview Graphics 
Area Toolbar

Provides direct access to commands for managing the Graphics Area. See 
“Graphics Area Toolbar for Overview Screens” on page 76 for 
descriptions of each icon. 

B Graphs Graphs are tiled in rows of up to three. Up to five rows can be displayed.

C Overview Graph 
Pane Toolbar

Provides direct access to commands for manipulating the display of this 
graph pane. See “Graph Pane Toolbar for Overview Screens” on page 76 
for details. 

D Graph Pane title Identifies the graphed attribute. 

E Graph Pane border Shaded area at the top of the graph pane. Allows you to grab the pane 
and move it. See “Rearrange Graph Panes” on page 84 for details. 

F Graph Area where the body of the graph is displayed. The horizontal axis is 
always Date, and the vertical axis is the unit of measure for the displayed 
values. 

G Legend Key to the items included on the graph. 

H Vertical scrollbar Appears only if the there are too many graphs to display in one row. 
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Graphics Area Toolbar for Overview Screens 

The Overview Graphics Area Toolbar appears at the top of the Graphics Area. It 
provides direct access to frequently used commands for controlling the overall 
display of the Graphics Area.

Graph Pane Toolbar for Overview Screens 

The Overview Graph Pane Toolbar appears at the top of each graph pane on 
Overview screens. It provides direct access to frequently used commands for 
modifying the graph pane. 

Icon Name Description

Help Displays help for the Graphics Area. 

Related Task: “Help”

Narrow View Tiles graph panes across the Graphics Area in rows of up to 
three graphs each. This is the default view. 

Related Task: “Switch Between Narrow and Wide Views”

Wide View Expands each graph horizontally across the entire Graphics 
Area with individual graphs stacked vertically. 

Related Task: “Switch Between Narrow and Wide Views” 

Printable Graphs Provides a “quick print” function. Displays a printable form of 
the displayed graphs in a separate browser tab or window. 

Related Task: “Perform a Graph “Quick Print”” 

Add Graph Adds a new graph pane displaying the default attribute to the 
Graphics Area. 

Related Task: “Add a Graph Pane” 

Icon Name Description

Choose Date 
Range

Displays the date editor, which allows you to change the date 
range to a new range or a single day. 

Related Task: “Change the Date Range”

Synchronize Date 
Range

Applies the date range for the current graphics pane to all 
graphics panes on the screen. 

Related Task: “Synchronize a Date Range Across All Graphs”
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Show Percentages Switches between real value and percentage value displays. 

Related Task: “Switch Between Actual and Percentage Values –
Overview Screens”

Change Graphed 
Attribute

Allows you to change the attribute displayed on the graph. 

Related Task: “Change the Graphed Attribute”

Detach Pane Detaches the graph from the screen and displays it in a separate 
window in the browser foreground. 

Related Task: “Detach a Graph Pane”

Remove Pane Deletes the graph pane from the screen. 

Related Task: “Remove a Graph Pane”

Icon Name Description
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Graphs on Analysis Screens 
The Graphics Area of Analysis screens consists of the Graphics Area Toolbar and one 
or more graph panes. Each graph pane also has a Graph Pane Toolbar.

The default Graphics Area on Analysis screens has just one graph pane, showing 
summary information for the overall system. The graphed attribute on Analysis 
screens is always the corresponding—drive or media—Health Indicator. 

You can change the number of graph panes and the data they display by selecting 
different row layers in the pivot table and applying the selection to the graphs. 
Whenever multiple panes are displayed, the left-most pane always shows summary 
information, and the remaining panes show detail. 

See “Data Graphing Tasks” on page 91 for detailed instructions. 
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Graphics Area Layout – Analysis Screens

Name Description

A Analysis Graphics 
Area Toolbar

Provides direct access to commands for managing the Graphics Area. See 
“Graphics Area Toolbar for Overview Screens” on page 76 for 
descriptions of each icon. 

B Graphs Graphs are tiled in rows of up to three. Up to five rows can be displayed. 
The default view shows one graph only. 

C Graph pane border Shaded area at the top of the graph pane. 

Note – Analysis screen graph panes cannot be 
rearranged. 

D Graph pane title Identifies the graphed attribute. 

E Analysis Graph Pane 
Toolbar

Provides direct access to commands for manipulating the display of this 
graph pane. See “Graph Pane Toolbar for Analysis Screens” on page 80 
for details. 

F Graph Area where the body of the graph is displayed. 

G Legend Key to the items included on the graph. 
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Graphics Area Toolbar for Analysis Screens 

The Analysis Graphics Area Toolbar appears at the top of the Graphics Area. It 
provides direct access to frequently used commands for controlling the overall 
display of the Graphics Area.

Graph Pane Toolbar for Analysis Screens

The Analysis Graph Pane Toolbar appears at the top of each graph pane on Analysis 
screens. It provides direct access to frequently used commands for modifying the 
graph pane. 

Icon Name Description

Help Displays help for the Graphics Area. 

Related Task: “Help”

Narrow View Tiles graph panes across the Graphics Area in rows of up to 
three graphs each. This is the default view. 

Related Task: “Switch Between Narrow and Wide Views”

Wide View Expands each graph horizontally across the entire Graphics 
Area with individual graphs stacked vertically. 

Related Task: “Switch Between Narrow and Wide Views”

Printable Graphs Provides a “quick print” function. Displays a printable form of 
the displayed graphs in a separate browser tab or window. 

Related Task: “Perform a Graph “Quick Print””

Icon Name Description

Show Percentages Toggles between real value and percentage value displays. 

Related Task: “Switch Between Actual and Percentage Values –
Analysis Screens”

Detach Pane Detaches the graph from the screen and displays it in a separate 
window in the browser foreground. 

Related Task: “Detach a Graph Pane”
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Graph Display Tasks
These procedures allow you to modify the appearance and arrangement of graphs on 
the STA screen. Some tasks apply to both Overview and Analysis screens, while 
others apply to Overview screens only; this distinction is identified at the top of each 
procedure. 

Task Page

Detach a Graph Pane 82

Rearrange Graph Panes 84

Add a Graph Pane 86

Remove a Graph Pane 87

Switch Between Narrow and Wide Views 88

Perform a Graph “Quick Print” 90
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▼Detach a Graph Pane

Note – This procedure applies to both Overview and Analysis 
screens. 

Use this procedure to separate a graph pane from the Graphics Area and display it in 
a separate window in the browser foreground. Once you have detached a graph 
pane, you can resize it and move it anywhere within the browser window. You can 
detach only one pane at a time. 

1. Click the Detach icon in the Graph Pane Toolbar.

The graph pane is displayed in a separate window in the screen foreground. 

Note – If you navigate to another screen, the pane is automatically 
closed. 

2. Optionally, you can move or resize the pane as follows:

• To move the pane, click and drag the top border.
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• To resize the pane, click and drag an edge or corner.

3. To restore the graph pane to its normal position, do either of the following:

• Click the Close button in the Graph Pane Toolbar. 

• Click the Detach Pane icon in a second graph pane. This restores the first 
graph pane to its normal position and displays the second graph pane in the 
foreground. 
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▼Rearrange Graph Panes

Note – This procedure applies to both Overview screens only. 

Use this procedure to rearrange graph panes in the Graphics Area. This procedure 
can be used in narrow view or wide view. 

1. Move the mouse over the Graph Pane border of the pane you want to move. The 
Move Object cursor appears.

2. Click and drag the pane to its new location.

3. Once the pane is near the position you want, release the cursor. 
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The pane snaps into place. You do not need to position it exactly. 
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▼Add a Graph Pane

Note – This procedure applies to Overview screens only. 

Use this procedure to add a graph pane to the screen. Data is displayed in the new 
graph according to the following criteria:

• The graph displays the default attribute for the resource type. For media, the 
default is Data Mounts; for drives, it is MB Read. You can change the attribute to 
any available attribute for the resource. 

• If the existing graph panes have all been synchronized to the same date range, the 
new graph uses the same one; otherwise, the graph uses the system default date 
range of the previous 30 days. 

• The new graph displays actual values, even if all the existing graphs display 
percentages. 

• If individual resources have been applied to the existing graphs, the new graph 
displays the same ones. 

1. Click the Add Graph icon on the Graphics Area Toolbar. 

Note – You can display up to 15 graph panes at a time; once you 
reach 15, the Add Graph icon is disabled (dimmed). 

The graph pane is added to the end of the Graphics Area display. You may need to 
use the vertical scrollbar to view the graph. 

• To move the pane to a new position, see “Rearrange Graph Panes” on page 84. 

• To graph a different attribute, see “Change the Graphed Attribute” on page 92.
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▼Remove a Graph Pane

Note – This procedure applies to Overview screens only. 

Use this procedure to delete a graph pane from the Graphics Area display.

1. Click the Remove Pane icon on the Graph Pane Toolbar.

The pane is removed from the display.

See “Add a Graph Pane” on page 86 for instructions on restoring the graph pane 
to the display. 
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▼ Switch Between Narrow and Wide Views

Note – This procedure applies to both Overview and Analysis 
screens. 

Use this procedure to display graphs in narrow and wide formats. Narrow view is 
the default, and it allows you to do side-by-side comparisons of graphed attributes. 
Wide view allows you to see each graph in greater detail. 

1. Click the Wide View icon on the Graphics Area Toolbar.
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The display changes to wide view, in which each graph pane is expanded 
horizontally across the entire Graphics Area. A vertical scrollbar appears, allowing 
you to scroll down to the remaining panes. 

2. To switch back to narrow view, click the Narrow View icon in the Graphics Area 
Toolbar.
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▼ Perform a Graph “Quick Print”

Note – This procedure applies to both Overview and Analysis 
screens. 

Use this procedure to perform a “quick print” of all graphs currently displayed. 

Note – For best results, you might want to display the graphs in 
Wide View mode. This will allow you to see more detail in the 
printed graphs. 

1. Click the Printable Graphs icon on the Graphics Area Toolbar.

A new tab is created in your browser window, showing all graphs in a printable 
format. 

2. You can use your browser’s standard Print function to send this display to a 
printer. 



Data Graphing Tasks

December 2012 Graph Displays  91

 

Data Graphing Tasks
These procedures allow you to modify the data that is displayed on one or more 
graph panes. Some tasks apply to both Overview and Analysis screens, while others 
apply to only one screen type; this distinction is identified at the top of each 
procedure.

Task Page

Change the Graphed Attribute 92

Change the Date Range 94

Synchronize a Date Range Across All Graphs 97

Add Library Resources to Graphs 99

Switch Between Actual and Percentage Values – Overview Screens 101

Switch Between Actual and Percentage Values – Analysis Screens 103

Graph Detail for a Pivot Table Attribute 105

Graph Aggregated Data From a Pivot Table 107
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▼Change the Graphed Attribute

Note – This procedure applies to Overview screens only. 

Use this procedure to change the resource attribute that is displayed in a graph pane. 

1. Click the Change Graphed Attribute icon in the Graph Pane Toolbar.

A menu appears, displaying all available attributes for this resource type. Only 14 
attributes are visible at a time. A scroll button at the bottom of the menu allows 
you to scroll down through the entire list. 
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2. Select the attribute you want the graph to display.

The graph is updated according to your selection.
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▼Change the Date Range

Note – This procedure applies to Overview screens only. 

Use this procedure to change the date range on a graph pane. You can specify a new 
range or a point in time (single day). 

1. Click the Choose Date Range icon on the Graph Pane Toolbar. 

The Choose Date Range dialog box appears.

2. Complete the dialog box, specifying either a single day or a range of dates. 

• For a point in time, do the following:

a. Select the Point In Time option. 
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ii. In the Date field, specify the date you want to display. You can specify 
the date manually or click the Select Date icon on the dialog box to bring 
up the Date editor and choose the date. The date format is yyyy-mm-dd. 

• For a range of dates, do the following:

i. Select the Time Range option. 

ii. In the Starting Date and Ending Date fields, enter the first and last dates 
of the range. You can specify the dates manually or click the Select Date 
icon on the dialog box to bring up the Date-time editor and choose the 
dates. The date format is yyyy-mm-dd. 

3. When the date selection is as you want, click OK.

The graph is updated according to your selection.
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• New point in time (point-in-time graphs are displayed as bar charts):

• New date range (date range graphs are displayed as line graphs):
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▼ Synchronize a Date Range Across All Graphs

Note – This procedure applies to Overview screens only. 

Use this procedure to synchronize all graph panes to the same date range. 

1. In one graph pane on the screen, set the date range you want to apply to all the 
panes. See “Change the Date Range” on page 94 for instructions. 

2. Click the Synchronize Date Range button in the Graph Pane Toolbar of that 
graph pane. 
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The Synchronize Graphs confirmation dialog box appears. 

3. Click Yes to synchronize. 

All graph panes in the Graphics Area are synchronized to display the same date 
range. All other data display characteristics (graphed attribute, actual vs. 
percentage values, added resources) remain unchanged. 



Data Graphing Tasks

December 2012 Graph Displays  99

 

▼Add Library Resources to Graphs 

Note – This procedure applies to Overview screens only. 

Use this procedure to add selected library resources—such as libraries, drives, media, 
etc.—to all graph panes on the screen. In the default view, graphs display only the 
system average for the graphed attribute. 

1. In the List View table, select one or more resources.

Note – You can use multi-select to select more than one resource; 
see “Multi-select” on page 47 for details. 

2. Click the Apply Selection icon on the List View Toolbar.
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The selected resources are added to all graph panes on the screen.

Note – Depending on the data values for the selected resources, 
the scale of one or more graph panes may change. The scales of 
the horizontal and vertical axes automatically adjust to show a 
useful amount of detail for the selected resources. 

3. You can change the selected resources, as follows:

• To remove these resources and add different ones, repeat Step 1 and Step 2, this 
time selecting different resources. 

• To remove all resources from the graphs and display just the System Average, 
deselect all the selected resources in the table and click the Apply Selection 
icon again.
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▼ Switch Between Actual and Percentage Values – Overview 
Screens

Note – This procedure applies to Overview screens only. 

Use this procedure to switch between actual and percentage values on a graph pane. 
Actual values are displayed by default. Percentage values compare individual 
resources within a set of selected resources; therefore, displaying percentage values is 
most useful when at least two resources have been added to the graph. 

1. Add two or more resources to the graph. See “Add Library Resources to 
Graphs” on page 99 for detailed instructions. 

2. Click the Show Percentages icon on the Graph Pane Toolbar. 
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The graphed values change from actual to percent, and the line graph changes to 
an area chart. 

3. The Show Percentages icon acts as a toggle. You can click it again to switch back 
to actual values. 
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▼ Switch Between Actual and Percentage Values – Analysis 
Screens

Note – This procedure applies to Analysis screens only. 

Use this procedure to switch between actual and percentage values on a graph pane. 
Actual values are displayed by default. Percentage values compare individual 
resources within a set of selected resources; therefore, displaying percentage values is 
most useful when at least two resources have been added to the graph. 

1. Click the Show Percentages icon on the Graph Pane Toolbar. 

The graphed values change from actual to percent, and the bar chart changes to a 
pie chart.
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2. The Show Percentages icon acts as a toggle. You can click it again to switch back 
to actual values. 
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▼Graph Detail for a Pivot Table Attribute

Note – This procedure applies to Analysis screens only. 

Use this procedure to graph detail data for a pivot table attribute. This results in just 
one graph pane in the Graphics Area. 

Note – You can graph attributes that appear on the row edge only, 
and only one row at a time. If you select a column edge attribute, 
or if you select multiple rows, you will see the error, “Please select 
one and only one row.”

1. In the pivot table, select a row that shows one value for an attribute. 

Note – In this example, the “HP” value for the Drive 
Manufacturer attribute is selected. 
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2. Click the Apply Selection icon in the Pivot Table Toolbar. 

The selected attribute value is displayed in a single graph pane. 
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▼Graph Aggregated Data From a Pivot Table 

Note – This procedure applies to Analysis screens only. 

Use this procedure to graph aggregated data from a pivot table. This results in 
multiple graph panes in the Graphics Area: one for the aggregated totals and one 
each for the attribute values included in the totals.

Note – You can graph attributes that appear on the row edge only, 
and only one row at a time. If you select a column edge attribute, 
or if you select multiple rows, you will see the error, “Please select 
one and only one row.”

1. In the pivot table, select a layer that aggregates multiple attribute values. 

Note – In this example, the nesting layer is “Library Number”, 
which aggregates data for two drive manufacturers: “HP” and 
“STK”. 



Data Graphing Tasks

108  STA User Interface Guide December 2012 

 

2. Click the Apply Selection icon in the Pivot Table Toolbar.

The Graphics Area is updated as follows:

• The left-most pane shows the summary data for the attribute.

• The panes to the right show detail for each attribute included in the 
aggregation, one pane per attribute. In this example, there are two detail panes: 
one for “HP” and one for “STK”. 
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5

Table Displays

Tables appear in the Main Window of the following types of screens:

• Dashboard

• Overview

• Analysis

This section describes the types of tables available and provides instructions for 
modifying their display. The following topics are discussed:

• “Areas of the Main Window” on page 110

• “List View Tables” on page 111

• “List View Table Layout” on page 112

• “List View Table Toolbar” on page 113

• “Pivot Tables” on page 115

• “Pivot Table Layout” on page 116

• “Pivot Table Toolbar” on page 117

• “List View Table Display Tasks” on page 118

• “Pivot Table Layout Tasks” on page 140

• “Table Data Export Tasks” on page 156
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Areas of the Main Window
All STA Overview and Analysis screens follow the same general structure and layout. 
The Main Window is divided into a Graphics Area at the top, and a Table Area at the 
bottom. The border between the two areas is marked by the Collapse Pane icon, 
which is visible at all times, and the Resize control bar, which appears when you 
move the mouse over the space between the two areas. 

The Table Area consists of either a List View table or a pivot table. See the following 
sections for details:

• “List View Tables” on page 111 

• “Pivot Tables” on page 115 
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List View Tables
List View tables appear on Overview screens. They display data in rows and 
columns, with one row for each library resource or event (drive or exchange, for 
example) and one column for each attribute of that resource.

You can change the display of a List View table by rearranging, sorting, and resizing 
the columns. 

Some List View table cells contain text links. These links provide access to additional 
details about the selected item(s). See “Resource ID Links” on page 50 for details. 

Note – Data in STA tables is display only; no modification is 
allowed. 

See “List View Table Display Tasks” on page 118 for details on how you can modify 
the display of these tables. 
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List View Table Layout

Name Description

A List View Table 
Toolbar

Provides direct access to the most frequently used table commands. See 
“List View Table Toolbar” on page 113 for descriptions of each icon. 

B Applied Filter Appears only if the data in the table has been filtered. Description of the 
filter criteria that have been applied. An asterisk (*) next to a filter 
criterion indicates that it has been filtered exclusively. See “Filtering 
Overview” on page 164 for details. 

Note – Filter descriptions longer than 250 characters 
are truncated. You can hover the cursor over the text 
to display a tooltip containing the full description.

C Sorted Column 
indicator

Appears if the table is sorted by this column. The dark arrowhead 
indicates the order of the sort (ascending or descending). See “Sort by a 
Column” on page 126 for details. 

D Column headings Identifies the resource attribute displayed in the column. 

E Selected rows 
indicator

Highlighted in blue. Some List View Table Toolbar icons become active 
only when rows are selected. 

F Active links Indicated by blue text. Click the link to display detail for that item. See 
“Display Detail for One or More Resources” on page 136 for details.

G Data area Area where the data cells are displayed. 

H Vertical and 
horizontal scrollbars

Appear only if the table is too large to display in the screen area. Allow 
you to scroll through the entire table display. 

I Table status line Indicates the number of selected rows, hidden columns, frozen columns, 
and records displayed. 
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List View Table Toolbar

The List View Table Toolbar appears above all List View tables and provides direct 
access to the most frequently used activities. 

Icon Name Description

Help Displays help for this area of the screen. 

Related Task: “Help”

List View Displays data in a list format, which is the default for List 
View tables. 

Related Task: “Display Detail for One or More Resources”

Detail View Displays detailed data for selected resources in a page format. 

Printable Table Provides a “quick print” function. Displays a printable form 
of the currently displayed data in a separate browser tab or 
window.   

Related Task: “Perform a Table “Quick Print””

Applied Filter Displays filter criteria that have been applied to the table. If 
the table data is not filtered, this area is blank. 

Note – Filter descriptions longer than 250 
characters are truncated. You can hover the 
cursor over the text to display a tooltip 
containing the full description. 

Related Topic: “Filtering Overview”

View menu Provides options for modifying the table display, such as sort 
order and hidden and revealed columns. 

Related Task: “List View Table Display Tasks”

Apply Selection Applies the currently selected table rows to the graphs in the 
Graphics Area. 

Related Task: “Add Library Resources to Graphs”

Export Exports the currently displayed table data to a file that can be 
viewed and edited with Microsoft Excel. 

Related Task: “Export Table Data to a Spreadsheet”

Filter Data Displays a dialog box that allows you to define, modify, or 
reset filter criteria and then apply them to the table. 

Related Task: “Use the Filter Data Dialog Box to Change a 
Table Filter”
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Detach Detaches the table from the screen and displays it in a 
separate window in the browser foreground. 

Related Task: “Detach a Table”

Current Page 
Number

Displays the current table page number and allows you to go 
directly to a specified page. Appears only for Exchanges, 
Cleaning Activities, and Notifications tables. 

Related Task: “Display a Specific Table Page” 

Icon Name Description
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Pivot Tables
STA provides real-time advanced data manipulation through pivot tables. Pivot 
tables appear on Analysis screens, and they show data that is aggregated into 
different categories, or “layers”. Layers can be nested within one another along the 
table column and row edges. By adding and removing layers and nesting layers in 
different ways, you can break down the table data into different aggregations without 
the need to open multiple windows or export data to a spreadsheet. 

For example, you can use pivot tables to look at the health of drives, not just by 
library location, but also by drive type, firmware level, and many other attributes. 
The following table, from the Drives – Analysis screen, shows the number of 
occurrences of each drive health indicator (ACTION, MONITOR, etc.), aggregated by 
drive manufacturer, library, and library complex. 

Note – A pivot table layer represents a resource attribute, such as 
drive health or media type. Pivot tables can display two to seven 
attributes, total. Two is the minimum because there must be one 
for each edge. 

• There is one column layer on the top edge of the table: Drive Health Indicator. 

• There are three row layers on the left edge of the table: Library Complex, Library 
Number, and Drive Manufacturer. The layers are nested from left (outer) to right 
(inner). In this example, Library Complex is the outermost layer, and Drive 
Manufacturer is the innermost. 

• Individual heading cells identify the different values for the layer attribute. The 
column layer, Drive Health Indicator, has the following values: ACTION, 
MONITOR, UNKNOWN, and USE; the outermost row layer, Library Complex 
Name, has the following values: A-SL8500, B-SL3000, and C-SL500.

• Counts are automatically subtotaled for each layer, which in this case are Drive 
Manufacturer Total, Library Number Total, and Library Complex Total. 

The aggregate counts in each pivot table cell are active links. These links provide 
access to additional details about the items included in the count. See “Aggregate 
Count Links” on page 50 for details. 

By aggregating data, pivot tables allow you to see data patterns that might not be 
obvious in a regular List View table. The format of a pivot table is dynamic in that 
you can change the way the data is organized simply by dragging and dropping—
”pivoting”—the layers from one area to another. Moving a layer within the same 
edge (shifting layers within the row edge, for example) changes the nesting order. 
Moving a layer to the opposite edge (moving a layer from row to column edge, for 
example) adds the layer there. 
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See “Pivot Table Layout Tasks” on page 140 for details on how you can modify their 
display. 

Pivot Table Layout

A Pivot Table Toolbar Provides direct access to the most frequently used commands. See “Pivot 
Table Toolbar” on page 117 for descriptions of each icon. 

B Column layer 
headings

Arranged along the top edge of the table. Layers are nested from top to 
bottom within the heading area. Individual heading cells identify the 
different values for the layer attribute. 

C Row layer headings Arranged along the left edge of the table. Layers are nested from left to 
right within the heading area. Individual heading cells identify the 
different values for the layer attribute.

D Layer subtotal Subtotals are automatically provided for each row and column layer. 
Subtotal cells are highlighted in light yellow. 

E Data area Area where the data cells are displayed. The data values are aggregate 
counts and are all active links. Aggregate cells are white. 

F Horizontal scrollbar Appears only if the table is too large to display in the screen area. Allows 
you to scroll through the entire table display. 

G Table status line Indicates how many rows or cells are selected. 

Applied Filter
(not shown)

Appears only if the data in the table has been filtered. Indicates the filter 
criteria that have been applied. See “Filtering Overview” on page 164 for 
details. 

Note – Filter descriptions longer than 250 characters 
are truncated. You can hover the cursor over the text 
to display a tooltip containing the full description.
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Pivot Table Toolbar

The Pivot Table Toolbar appears above all pivot tables and provides direct access to 
the most frequently used pivot table commands. 

Icon Name Description

Help Displays help for this area of the screen. 

Related Task: “Help”

Change Attributes Displays a dialog box that allows you to show, hide, or reorder 
attributes in the table. 

Related Task: “Add Library Resources to Graphs”

Apply Selection Applies the currently selected table rows to the graphs in the 
Graphics Area. 

Related Task: “Add Library Resources to Graphs”

Export Exports the currently displayed table data to a file that can be 
viewed and edited with Microsoft Excel. 

Related Task: “Export Table Data to a Spreadsheet”

Filter Data Displays a dialog box that allows you to define, modify, or reset 
filter criteria and then apply them to the table. 

Related Task: “Use the Filter Data Dialog Box to Change a 
Table Filter”

Applied Filter Displays filter criteria that have been applied to the table. If the 
table data is not filtered, this area is blank. 

Note – Filter descriptions longer than 250 
characters are truncated. You can hover the 
cursor over the text to display a tooltip 
containing the full description. 

Related Topic: “Filtering Overview”
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List View Table Display Tasks
The following tasks provide instructions for modifying the display of List View 
tables. See “List View Tables” on page 111 for a description of the features and 
benefits of List View tables. 

Task Page

Detach a Table 119

Move a Column 120

Change the Width of a Column 123

Sort by a Column 126

Sort by Multiple Columns 128

Hide and Reveal Columns 131

Display a Specific Table Page 134

Display Detail for One or More Resources 136

Perform a Table “Quick Print” 138
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▼Detach a Table 

Detaching a table separates it from the STA screen and displays it in a separate 
window in the browser foreground. Once you have detached a table, you can resize it 
and move it anywhere within the browser window. 

1. Use either of the following methods to detach the table:

• By Mouse: Click the Detach icon in the Table Toolbar. 

• By Menu: In the Table Toolbar, select View > Detach. 

The table is displayed in a separate window in the screen foreground. The rest of 
the screen is dimmed in the background. The table title displays “Detached 
Table”. 

2. To restore the table to its normal position, use either of the following methods:

• By Mouse: Click the Close button in the Table Toolbar. 

• By Menu: In the Table Toolbar, select View > Attach. 
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▼Move a Column

Use this procedure to reorder columns in a table. 

Note – The column on the far-left is fixed and therefore cannot be 
moved. When you move the mouse over the header of this 
column, the cursor changes to the Select fixed column cursor. 

By mouse

1. Click in the heading of the column you want to move. 

The entire column is highlighted, indicating it has been selected.

2. Click and drag the column heading; the cursor changes to the Move object 
cursor. 

3. Once the column is close to the position you want, release the cursor. 

The column snaps into place. You do not need to position it exactly. 

By menu

1. In the Table Toolbar, select View > Reorder Columns.
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The Reorder Columns dialog box appears. All revealed, moveable columns are 
listed in their current order on the screen. Fixed and hidden columns are not 
listed. 

2. In the list, select the columns you want to move. This dialog box supports 
Multi-select. 

3. Click one of the arrows on the right side of the screen to move the items. 

Moving items up the list causes the columns to be moved to the left in the table 
display; moving them down the list causes the columns to be moved to the right.

or Move the selected item(s) up or down, one place at a time. 

or Move the selected item(s) to the top or bottom of the list. 
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4. Repeat this process until the Visible Columns list is arranged the way you 
want, and then click OK. 

The columns are reordered according to your selections.
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▼Change the Width of a Column

Use this procedure to adjust the width of a table column. 

By mouse

1. Move the mouse over the right-hand border of the column heading until the 
Resize column cursor appears. 

Note – Columns are resized from the right side only. 

Note – You cannot resize a column from the data rows area. 

Note – In this example, the Drive WWNN column will be resized, 
and the width of the Drive Serial Number column will not change. 

2. Click and drag the border, as follows:

• To make the column narrower, drag to the left.

• To make the column wider, drag to the right. 

A dotted vertical line appears to indicate the pending width. You can move the 
border back and forth as much as you want until you get the right width. 

3. When the column is the width you want, release the cursor. 

The column is resized. All other columns retain their original widths. 
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By menu

1. Right-click the heading of the column you want to resize, and select Resize 
Columns.

The Resize Column dialog box appears, displaying the current width of the 
column.

2. Complete the dialog box in either absolute or relative units. 

• For absolute units, do the following:

i. In the menu, select Pixels.

ii. In the Width field, enter the number of pixels for the new width.

Note – You can also use the spinbox up-arrow and down-arrow to 
increase or decrease the value in the Width field. 

• For relative units, do the following:

i. In the menu, select Percent.

ii. In the Width field, enter the percent change you want to make to the 
current column width. 

Note – You can also use the spinbox up- and down-arrows to 
increase or decrease the value in the Width field. 
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This percentage will be multiplied by the current width to calculate the new 
width. For example: an entry of 200 doubles the current width; an entry of 
25 reduces the current width to one-quarter of what it is now. 

3. Verify the settings are the way you want, and then click OK.

The column is resized. All other columns retain their original widths. 
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▼ Sort by a Column

Use this procedure to sort the table by a single column. To do a nested sort using 
multiple columns, see “Sort by Multiple Columns” on page 128. 

Note – For screens that include a “Current Page Number” field 
(Libraries – Exchanges, Drives – Cleaning Activities, and 
Notifications – Overview), the sort applies only to the records 
displayed on the current page. 

By mouse

1. Move the mouse over the heading of the column you want to sort until the sort 
arrowheads appear.

2. Click either the Ascending or Descending arrowhead, depending on the order 
you want the data to be sorted. In this example, the Ascending arrow is selected. 

The table data is resorted according to your selection, and the Sorted Column 
indicator highlights the sort order (ascending, in this example). 

By menu

1. Click in the heading of the column you want to sort. 
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The entire column is highlighted, indicating it has been selected.

2. Make the menu selection using either of the following methods:

• Right-click the column heading and select Sort > Ascending or 
Sort > Descending. 

 

• In the Table Toolbar, select View > Sort > Ascending or View > Sort > 
Descending. 

3. The table data is resorted according to your selection, and the Sorted Column 
indicator highlights the sort order (descending, in this example). 
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▼ Sort by Multiple Columns

Use this procedure to do a nested sort, using up to three columns. 

Note – For screens that include a “Current Page Number” field 
(Libraries – Exchanges, Drives – Cleaning Activities, and 
Notifications – Overview), the sort applies only to the records 
displayed on the current page. 

Note – For screens that include a “Current Page Number” field 
(Libraries – Exchanges, Drives – Cleaning Activities, and 
Notifications – Overview), the sort applies only to the records 
displayed on the current page. 

Note – This activity can only be done by menu, not by mouse. 

1. Make the menu selection using either of the following methods:

• In the Table Toolbar, select View > Sort > Advanced.

• Right-click in any column heading and select Sort > Advanced.

The Advanced Sort dialog box appears. 
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2. In the Sort By menu, select the column for the primary sort. If a default value 
has been supplied, you can override it. 

3. Select either the Ascending or Descending options to indicate the sort order you 
want to use.

4. Repeat this process for the remaining fields on the screen to indicate the criteria 
for up to two additional nested sorts. Click OK. 
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The table data is sorted according to your selections, and the column headers 
indicate the sort criteria.
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▼Hide and Reveal Columns

Use this procedure to change which columns are revealed in a table and which are 
hidden. 

Note – This task can done only by menu, not by mouse. 

1. Display the table column list using either of the following methods:

• In the Table Toolbar, select View > Columns.

• Right-click any column heading and select Columns.

The menu displays a list of available columns in alphabetical order; up to 10 items 
are shown in this list. The columns currently included in the table are indicated by 
check marks. 

2. To change the table display, do one of the following:

• Select Show All to add all columns to the table. See Step 7. 

Note – This will result in a very wide table. 
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• Select a column on the list to add it to the table, or deselect a column to remove 
it. See Step 7. 

• Select Show More Columns to display the complete list of all columns 
available for the table. See Step 3.

3. The Show More Columns dialog box appears. 

The Visible Columns list identifies the columns currently included in the table and 
their order. The Hidden Columns list identifies columns that are currently hidden; 
they are listed in the order defined in the current template.   

4. Arrange the columns so that the ones you want to display are included in the 
Visible Columns list and the ones you want to remove are in the Hidden 
Columns list. 

a. Select the columns you want to move from one list to the other. This dialog 
box supports Multi-select. 

b. Click an arrow to move the items, as follows:

c. Repeat this process until both lists include the items you want. 

or Move the selected item(s) to the indicated list.

or Move all items from one list to the other.
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5. Optionally, you can reorder the items in the Visible Columns list by using the 
reorder arrows on the right side of the dialog box. 

Moving items up the list causes the columns to be moved to the left in the table 
display; moving them down the list causes the columns to be moved to the right.

a. Select the items you want to move. This dialog box supports Multi-select.

b. Click an arrow to move the items, as follows:

c. Repeat this process until the Visible Columns list is arranged the way you 
want.

6. Verify that the dialog box is arranged the way you want, and then click OK.

7. The table display is updated according to your selections. 

or Move the selected item(s) up or down, one place at a time. 

or Move the selected item(s) to the top or bottom of the list. 
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▼Display a Specific Table Page 

Use this procedure to go directly to a specific page on Libraries – Exchanges, 
Drives – Cleaning Activities, or Notifications – Overview screens. 

Because a large number of exchanges and notifications can be generated in a short 
time, these screens can display many records. The records are therefore grouped into 
“pages”; each page consists of 1,000 records sorted as follows:

• Libraries – Exchanges and Drives – Cleaning Activities screens — Reverse order 
of “Exchange Start” time (most recent exchanges first)

• Notifications – Overview screen — Reverse order of “Date SNMP Trap Received” 
time (most recent traps first)

Note – This activity can be done only by mouse, not by menu. 

1. Move the cursor over the record count area on the right side of the Table Status 
line.

The cursor changes from the default pointer to a text pointer.

2. Click anywhere within the record count area. 

A message appears indicating the total number of records in the table. 

3. Click OK to dismiss the message. 
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4. In the Current Page Number field in the Table Toolbar, enter the page number 
you want to display and then press Enter.

The specified table page is displayed. 

Note – Each page but the last contains 1,000 records. Therefore, 
each page but the last indicates “Displaying 1,000 records” in the 
record count area of the Table Status Line. The examples below 
show pages 3 and 4 of a table containing 3,185 total records. 
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▼Display Detail for One or More Resources 

Use this procedure to display detailed information for one or more resources. 

1. Select the resource(s) you want to display, as follows:

• If you want to display detail for just one resource, click the active link. Active 
links are indicated by blue text. 

• If you want to display detail for multiple resources, use Multi-select to select 
the rows the resources are in, and then click Detail View. (See “Multi-select” 
on page 47 for details.)

Note – To select a row, click in any column except one that 
contains an active link; if you click in a column with an active link, 
you will activate the link.

2. The Detail View screen appears.

If you have selected multiple resources, they are displayed, in order of ID. The ID 
is displayed in the header of each record. Use the scrollbar to see all the resources.
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3. You can follow any active links on this screen to get to additional information. 

On this screen, active links are indicated by underlined blue text. In this example, 
the Volume Serial Number and Exchange Start fields are active links. 

See “Use Resource ID Links to Navigate” on page 58 for additional information. 

4. To return to the List View table, click List View. 
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▼ Perform a Table “Quick Print” 

Use this procedure to perform a “quick print” of currently displayed table data. 

Note – For the List View, this function provides just a snapshot of 
the current display in the table area; as such, only a subset of table 
records and columns may be included. To print a true rendering of 
all table data, it is recommended that you export the table data to 
a file and print from there. See “Export Table Data to a 
Spreadsheet” on page 157. 

Note – For the Detail View, this function includes all data in the 
table area. 

Note – Depending on the width of the display, you may need to 
specify landscape layout when you print. 

1. Display the data that you want to print, as follows:

• To print data in the List View format, scroll to the area of the table that you 
want to print.

Note – This step is necessary because the quick print function 
displays only a subset of table records, starting with the first row 
displayed on the screen. 

• To print data in the Detail View format, select the library resources you want to 
print and click the Detail View icon. See “Display Detail for One or More 
Resources” on page 136 for details. 
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2. Click the Printable Table icon on the List View Table Toolbar.

A new tab is created in your browser window, showing the table data in a 
printable format. 

3. You can use your browser’s standard Print function to send this display to a 
printer. 
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Pivot Table Layout Tasks
The following tasks provide instructions for modifying the layout of pivot tables to 
aggregate data in different ways. See “Pivot Tables” on page 115 for a description of 
the features and benefits of pivot tables. 

Task Page

Display the Name of a Layer 141

Change the Width of a Column or a Row Header 142

Change the Height of a Row 144

Display Detail for an Aggregate Count 146

Select a Row Layer 147

Shift Layers on the Same Edge 148

Swap Layers on the Same Edge 150

Move a Layer to the Opposite Edge 152

Swap Layers on Opposite Edges 153

Change Table Attributes and Their Nesting Order 154
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▼Display the Name of a Layer

Use this procedure to display the name of the attribute that is displayed in a pivot 
table layer. 

1. Move the mouse over a row or column heading cell until the Select row or 
Select column cursor appears.   

The name is displayed in the layer border, as follows:

• Column layer borders are directly to the left of the layer: 

• Row layer borders are directly above the layer: 

Note – The name is truncated if the heading cell is not wide 
enough to display the entire name. To display the entire name, 
you can hover over the layer border until the tooltip appears. 
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▼Change the Width of a Column or a Row Header

Use this procedure to change the width of a column or a row layer header. 

By mouse

1. Move the mouse over the right-hand border of the column or row header until 
the Resize column cursor appears. 

Note – Columns are resized from the right side only. 

Note – You cannot resize a column from the data rows area. 

Note – In this example, the Library Complex Name column will 
be resized, and the width of the Library Number column will not 
change. 

2. Click and drag the border, as follows:

• To make the column narrower, drag to the left.

• To make the column wider, drag to the right. 

A dotted vertical line appears to indicate the pending width. You can move the 
border back and forth as much as you want until you get the right width. 

3. When the column is the width you want, release the cursor. 

The column is resized. All other columns retain their original widths. 
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By menu

1. Position the cursor within the header of the column you want to resize, until the 
Select column or Select row cursor appears. 

2. Right-click and select Width.

The Width dialog box appears, displaying the current width of the column.

3. In the Width field, enter the number of pixels for the new width. 

Note – You can also use the spinbox up- and down-arrows to 
increase or decrease the value in the Width field. 

4. Verify the settings are the way you want, and then click OK.

The column is resized. All other columns retain their original widths. 
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▼Change the Height of a Row

Use this procedure to change the height of a row or a column layer header. 

By mouse

1. Move the mouse over the lower border of the row or column header until the 
Resize row cursor appears. 

Note – You cannot resize a row from within the data area. 

Note – Rows are resized from the bottom only; therefore, in this 
example, the HP row will be resized, not the STK row.

2. Click and drag the border, as follows:

• To make the row taller, drag down.

• To make the row shorter, drag up. 

A dotted vertical line appears to indicate the pending height. You can move the 
border up and down as much as you want until you get the right height. 

3. When the row is the height you want, release the cursor. 

The row is resized. All other rows retain their original heights. 
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By menu

1. Position the cursor within the header of the row you want to resize, until the 
Select row or Select column cursor appears. 

2. Right-click and select Height.

The Height dialog box appears, displaying the current height of the row.

3. In the Height field, enter the number of pixels for the new height. 

Note – You can also use the spinbox up- and down-arrows to 
increase or decrease the value in the Height field. 

4. Verify the settings are the way you want, and then click OK.

The row is resized, and all other rows retain their original heights. 
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▼Display Detail for an Aggregate Count

Use this procedure to display detail for the resources included in an aggregate count. 

1. Click the active link of the aggregate count you want to display. Active links are 
indicated by blue text. 

You are taken to the associated Overview screen, and the filter intrinsic to the 
aggregate count is applied to the data in the List View table. See “Filtering Using 
Aggregate Count Links” on page 169 for details. 

2. You can follow any active links on this screen to get to additional information. 
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▼ Select a Row Layer

You can select one or more row layers at a time. The data cells belonging to the 
selected layer(s) are highlighted; this can serve as a visual aid to help you see data 
patterns. 

1. Move the mouse over a row layer heading until the cursor changes to the Select 
row cursor.

2. Click the header to select the entire layer. You can select multiple layers with 
Multi-select. 

The cells in the selected layer(s) are highlighted as follows:

• Aggregate count cells are highlighted in blue. 

• Summary cells are highlighted in gray. 
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▼ Shift Layers on the Same Edge

Use this procedure to shift the nesting level of layers on the same edge. 

By mouse

1. Move the mouse over the border of the heading you want to move, until the 
Move object cursor appears. 

2. Click and drag the layer over a layer separator until the separator is 
highlighted. 

When you release the cursor, the table is reorganized and the aggregate counts in 
the data cells are re-calculated. In this example, the Library Complex layer has 
been inserted between the Library Number and Drive Manufacturer layers. 
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By menu

See “Change Table Attributes and Their Nesting Order” on page 154 for instructions. 
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▼ Swap Layers on the Same Edge

Use this procedure to swap two layers on the same edge. 

By mouse

1. Move the mouse over the border of the heading you want to move, until the 
Move object cursor appears. 

2. Click and drag the first layer over the second layer until that layer’s headings 
are highlighted.

When you release the cursor, the table is reorganized and the aggregate counts in 
the data cells are re-calculated. In this example, the Library Complex layer has 
been swapped with the Drive Manufacturer layer. 
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By menu

See “Change Table Attributes and Their Nesting Order” on page 154 for instructions. 
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▼Move a Layer to the Opposite Edge

Use this procedure to move a layer from one edge to the other. 

By mouse

1. Move the mouse over the border of the heading you want to move, until the 
Move object cursor appears. 

2. Click and drag the layer over a layer separator on the opposite edge until the 
separator is highlighted. 

When you release the cursor, the table is reorganized and the aggregate counts in 
the data cells are re-calculated. In this example, the Library Complex layer has 
been inserted below the Drive Health Indicator layer on the column edge. 

By menu

See “Change Table Attributes and Their Nesting Order” on page 154 for instructions. 
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▼ Swap Layers on Opposite Edges 

Use this procedure to swap layers on opposite edges. 

By mouse

1. Move the mouse over the border of the heading you want to move, until the 
Move object cursor appears. 

2. Click and drag the layer over a layer on the opposite edge, until the second 
layer’s headings are highlighted.

When you release the cursor, the table is reorganized and the aggregate counts in 
the data cells are re-calculated. In this example, the Library Complex layer has 
been swapped with the Drive Health Indicator layer. 

By menu

See “Change Table Attributes and Their Nesting Order” on page 154 for instructions. 
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▼Change Table Attributes and Their Nesting Order

Use this procedure to change the attributes displayed in a pivot table. You can add 
and remove attributes in the table and change the order in which they are nested. 

Note – Pivot tables can include between two and seven attributes. 

1. In the Table Toolbar, click the Change Attributes icon.

The Change Attributes dialog box appears. The Selected Attributes list identifies 
the attributes currently included in the pivot table and their order. The Available 
Attributes list identifies attributes that are currently hidden.   

2. Arrange the attributes so that the ones you want to display are included in the 
Selected Attributes list and the ones you want to remove are in the Available 
Attributes list.

Note – The Selected Attributes list must include a minimum of 
two and a maximum of seven attributes. 

a. Select the attributes you want to move from one list to the other. This dialog 
box supports Multi-select. 

b. Click an arrow to move the items, as follows:

c. Repeat this process until both lists include the items you want. 

3. Optionally, you can reorder the items in the Selected Attributes list by using the 
reorder arrows on the right side of the dialog box. 

or Move the selected item(s) to the indicated list.

or Move all items from one list to the other.
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By default, the last attribute in the Selected Attributes list appears on the column 
edge of the table. The other attribute(s) appear on the row edge, nested in the 
order they appear in the list; the top attribute is the outer layer. 

a. Select the items you want to move. This dialog box supports Multi-select.

b. Click an arrow to move the items, as follows:

c. Repeat this process until the Selected Attributes list is arranged the way you 
want.

4. Verify that the dialog box is arranged the way you want, and then click OK.

The pivot table is updated according to your selections. 

or Move the selected item(s) up or down, one place at a time. 

or Move the selected item(s) to the top or bottom of the list. 
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Table Data Export Tasks 
The following tasks provide instructions for exporting data from List View or pivot 
tables. 

Task Page

Export Table Data to a Spreadsheet 157

Display an Exported Spreadsheet 159
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▼ Export Table Data to a Spreadsheet

Note – This procedure applies to both pivot and List View tables. 

Use this procedure to export an STA table to a file that can be viewed and edited with 
Microsoft Excel or a compatible spreadsheet application. Prior to performing this 
procedure you need to set up the table so it includes all the data you want to export. 
The exported data includes all resources and attributes included in the table, as 
follows:

• If you have applied a filter to the table, the spreadsheet includes only the records 
that match the criteria you have specified. 

• Data records and attributes currently scrolled off the visible portion of the screen 
are included.

• Hidden attributes are not included. 

The file is saved to your local computer. The data is saved in HTML format, but the 
file is given a .xls extension so you can easily open it in Microsoft Excel. See 
“Display an Exported Spreadsheet” on page 159 for options on viewing and editing 
the file. 

1. Set up the table so it displays all the data you want to export. 

Note – This procedure uses a List View table, but you could also 
use a pivot table.

A filter is applied in this example. 

2. Click the Export icon in the Table Toolbar. 

The file is downloaded to your computer according to your browser settings. See 
your browser documentation for details. Following is an example of a dialog box 
you might see on a computer running Windows. Note that the file will be saved 
with a .xls extension. 
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3. Proceed to “Display an Exported Spreadsheet” on page 159 for instructions on 
viewing and editing the file. 
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▼Display an Exported Spreadsheet

Use this procedure to view and optionally edit a file that you have created with 
“Export Table Data to a Spreadsheet” on page 157. The file is automatically assigned 
a .xls extension, but the data is actually in HTML format. As a result, you can 
display the file using either of the following options: 

• “Display the Spreadsheet With Excel”

• “Display the Spreadsheet in a Browser” on page 161

▼ Display the Spreadsheet With Excel

Because the file is saved with a .xls extension, you can easily open it in Microsoft 
Excel and perform spreadsheet functions on the data.

1. Keep the .xls extension on the file, and open it in Excel or a compatible 
spreadsheet application. 

An informational message is displayed. This message is normal, and it appears 
because the file is actually in HTML format. 

2. Click Yes to open the file. 

The file is displayed as an Excel spreadsheet. Depending on a variety of details, 
including the length of the numbers and the position of the data in the table, Excel 
may or may not convert some cells to scientific notation. This is an Excel 
formatting issue only and does not affect the integrity of the underlying data. 

In the following example, the cells in the “Drive Serial Number” column are 
displayed in scientific notation. 

3. To correct formatting issues with numeric data, perform the following steps:

a. Select the column header to highlight the entire column. 
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b. Right-click the column and select Format Cells. 

c. In the Format Cells dialog box, select Number in the Category column. 
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d. In the Decimal places field, type “0”. 

e. Leave all other fields as is, and click OK to save the changes. 

The cells are reformatted in standard notation. 

4. See the Microsoft Excel documentation for information about the various 
functions you can perform on the data in the spreadsheet. 

▼ Display the Spreadsheet in a Browser 

Because the file is in HTML format, you can display it in a browser window. Using 
this procedure, you can view and print the data, but you cannot modify it. 

1. Change the .xls file extension to .htm or .html. 

2. Open the file in your browser. 
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6

Filtering Table Data

STA enables you to filter the records displayed in pivot and list view tables. Table 
filters allow you to focus on a subset of information by displaying just the records 
that meet specific criteria. 

This section describes the effects of filters and the ways you can apply them. The 
following topics are discussed:

• “Filtering Overview” on page 164

• “Filter Application” on page 164

• “Filter Duration” on page 164

• “Applying a Filter” on page 165

• “Filter Data Dialog Box” on page 166

• “Filtering Using Aggregate Count Links” on page 169

• “Filtering by Applying a Template” on page 170

• “Filtering Using Dashboard Graphics” on page 171

• “Filtering Tasks” on page 172
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Filtering Overview
You can filter data by any table attribute, whether or not that attribute is currently 
displayed on the table. You can specify filter criteria for any number of attributes, 
and you can choose whether any or all of the criteria must be met. See “Applying a 
Filter” on page 165 for complete details. 

Once you apply a filter, the criteria are displayed in the Applied Filter area of the 
table. This allows you to verify which filter criteria have been applied to the current 
table view. If no criteria have been applied, this area is blank. 

Note – Filter descriptions longer than 250 characters are 
truncated. You can hover the cursor over the text to display a 
tooltip containing the full description.

Note – Text string filters are case-sensitive. For example, the text 
string “CLN” is not the same as “cln” or “Cln”. 

Filter Application

Some screens on the Drives and Media tabs are paired with one another. For these 
pairings, any filter applied on one screen is automatically applied to its partner. The 
screen pairings are as follows:

• Drives – Overview and Drives – Analysis

• Media – Overview and Media – Analysis 

With the exception of these pairings, a filter applies only to the screen on which you 
apply it. Following are examples:

• If you apply a filter to the Drives – Overview screen, the same filter is 
automatically applied to the Drives – Analysis screen, but not to Drives –
Cleaning Activities nor any other STA screen. 

• If you apply a filter to the Libraries – Overview screen (a screen with no 
“partner”), the filter applies to that screen only. 

Filter Duration

Once you have applied a filter to a screen, it remains in effect for the duration of your 
login session. If you navigate away from the screen and then return to it later in the 
session, the filter will still be in effect. To change or remove a filter, you must take one 
of the following actions: 

• Apply a new filter. See “Applying a Filter” on page 165 for details. 

• Remove the filter. See “Clear the Current Filter” on page 179 for details. 

• Apply a template; the filter criteria in a template overrides any existing criteria. 
See “Apply a Template” on page 199 for details. 

• Log out of STA. See “Log Out of STA” on page 22 for details. 
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Applying a Filter
You can apply a filter in any of the following ways:

• By completing the Filter Data dialog box for a pivot or list view table. See “Filter 
Data Dialog Box” for details. 

• By clicking an aggregate count link in a pivot table. See “Filtering Using 
Aggregate Count Links” on page 169 for details. 

• By applying a template. See “Filtering by Applying a Template” on page 170 for 
details. 

• By clicking a section of a bar chart or pie chart on the Dashboard. See “Filtering 
Using Dashboard Graphics” on page 171 for details. 
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Filter Data Dialog Box

The Filter Data dialog box appears when you click the Filter Data icon in either 
the List View Table Toolbar or the Pivot Table Toolbar. 

Name Description

A Filter Matching field Allows you to specify the type of match you want to perform. Select one 
of the following options: 

• Match ANY entered criteria – Selects table records that meet any of 
the criteria you specify. 

• Match ALL entered criteria – Selects only records that meet all of the 
criteria you specify

B Table attributes Lists all attributes that are available for the current table. You can specify 
filter criteria for as many attributes as you want. Each table attribute has 
a menu that includes one of the following:

• A list of pre-defined values for the attribute. 

• A list of comparison operators. The available operators vary, 
depending on the type of data. For these fields there is also an 
associated text entry field in which you enter the specified value for 
the comparison. 

See “Table Attribute Types” on page 167 for details. 
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Table Attribute Types

C Buttons Click one of the following buttons: 

• Apply – Applies the specified filter criteria to the table. See “Use the 
Filter Data Dialog Box to Change a Table Filter” on page 173 for 
details. 

• Reset – Removes all filter criteria so the table displays all records. See 
“Clear the Current Filter” on page 179 for details.

• Cancel – Exits from the dialog box without applying any changes. 

Name Description

Attribute Type Pull-down Menu Entries

Pre-defined values 

For example, Drive Health 
Indicator and Drive Type. 

• blank – Excludes the attribute from the selection criteria. This 
is always the first menu entry. 

• List of all possible values for the attribute. 

Note – The values listed do not necessarily 
reflect currently applied filters or the current 
removed drives and media display settings for 
your username. For example, the “Drive Type” 
pull-down menu may include drive types that 
are not currently included in any monitored 
libraries. 

Date

For example, STA Start Tracking 
and Last Exchange Start. 

• blank – Excludes the attribute from the selection criteria. This 
is always the first menu entry.

• Is Before – Selects entries with attribute dates on or before the 
one you specify. 

• Is – Selects entries with attribute dates equal to the one you 
specify. 

• Is After – Selects entries with attribute dates on or after the 
one you specify 

Enter the date in the associated text entry field. Use yyyy-mm-dd 
format. 
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Numeric 

For example, Media MB 
Available and Exchange Elapsed 
Time. 

• blank – Excludes the attribute from the selection criteria. This 
is always the first menu entry.

• Less Than – Selects records with attribute values less than or 
equal to (<=) the specified value. 

• Is – Selects records with attribute values equal to (=) the 
specified value.

• Greater Than – Selects records with attribute values greater 
than or equal to (>=) the specified value. 

Enter the value in the associated text entry field. Do not include 
units of measure, such as MB, in your entry. 

Text string 

For example, Volume Serial 
Number and Drive WWNN. 

• blank – Excludes the attribute from the selection criteria. This 
is always the first menu entry.

• Begins With – Selects records with attribute values that start 
with the specified string. 

• Contains – Selects records that contain the specified string 
anywhere within the attribute value. 

• Ends With – Selects records with attribute values that end 
with the specified string. 

Enter the string in the associated text entry field.   

Note – Your entry is case-sensitive. For 
example, the entry “CLN” is not the same as 
“cln” or “Cln”. 

Attribute Type Pull-down Menu Entries



Applying a Filter

December 2012 Filtering Table Data  169

 

Filtering Using Aggregate Count Links

The cells within pivot tables contain aggregate counts of resources or events that 
meet specific criteria (see “Pivot Tables” on page 115 for details). A filter is therefore 
intrinsic to each aggregate count. 

For example, in the following Drives – Analysis pivot table, the “5” in the MONITOR 
column indicates that there are a total of five drives with a health status of 
“Monitor”. 

Clicking on this link takes you to the Drives – Overview screen and applies the filter 
intrinsic to the aggregate count. The filter criteria are indicated in the Applied Filter 
area of the table.

Note – Filter descriptions longer than 250 characters are 
truncated. You can hover the cursor over the text to display a 
tooltip containing the full description.

See “Use an Aggregate Count Link to Apply a Filter” on page 182 for detailed 
instructions. 
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Filtering by Applying a Template 

Applying a template automatically applies any filter criteria that are included in the 
template definition. These criteria override any filter that may already be in effect. 

For example, the following Drives – Analysis pivot table has an applied filter, “Drive 
Health Indicator=USE”. 

Applying a template that includes a different filter, in this case “Drive Health 
Indicator=MONITOR”, changes the table display and causes the original filter to be 
overridden. 

The new filter criteria are indicated in the Applied Filter area of the table. 
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Filtering Using Dashboard Graphics 

Bar charts and pie charts on the Dashboard display aggregate data for resources or 
events that meet specific criteria. A filter is therefore intrinsic to each section of a 
Dashboard bar chart or pie chart. 

For example, in the following “Health by Media Type” graph, the selected section of 
the LTO-4 bar represents 34 drives with a health status of “Monitor”. 

Clicking this section of the bar takes you to the Media – Overview screen and applies 
the intrinsic filter. The filter criteria are indicated in the Applied Filter area of the 
table.



Filtering Tasks

172  STA User Interface Guide December 2012 

 

Filtering Tasks

Task Page

Use the Filter Data Dialog Box to Change a Table Filter 173

Clear the Current Filter 179

Use an Aggregate Count Link to Apply a Filter 182

Apply a Filter From the Dashboard 185
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▼Use the Filter Data Dialog Box to Change a Table Filter 

Note – This procedure applies to both pivot and list view tables. 

Use this procedure to apply new filter criteria to the current table. You can filter by 
one or more record attributes, and you can remove filter criteria from selected 
attributes. 

For screens that are paired with a “partner”, the filter applied to one screen is 
automatically applied to its partner. See “Filter Application” on page 164 for details. 

Note – For screens that include a “Current Page Number” field 
(Libraries – Exchanges, Drives – Cleaning Activities, and 
Notifications – Overview), the filter applies across all records, not 
just the ones displayed on the current page. 

1. Click the Filter Data icon in the Table Toolbar. 

Note – This procedure uses a List View table, but you could also 
use a pivot table.

The Filter Data dialog box appears. If no filter has been applied, the dialog box 
displays the default settings. If a filter is already in effect, the criteria are 
displayed in the dialog box, as in the example below. 
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2. Specify the filter criteria in the dialog box, as follows:

a. In the Filter Matching field, select one of the options to indicate whether you 
want to match any or all of the criteria you specify. See “Filter Matching 
field” on page 166 for details. 

b. Indicate the filter criteria in the remaining fields on the screen. See “Table 
Attribute Types” on page 167 for details on filling out this section of the 
screen.

• You can specify criteria for as many table attributes as you want.

Note – Text string entries are case-sensitive. For example, the 
entry “CLN” is not the same as “cln” or “Cln”. 

• You can remove previously specified filter criteria in selected fields by 
blanking them out.

In the example below, a Media Type is selected, and the previously specified 
Drive Health Indicator selection is removed. 
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3. Verify that your specifications are correct, and then click Apply.

The following updates are made to the table: 

• The table displays only the records that match the criteria you have specified.

• The Applied Filter area indicates the specified criteria. 

• For list view tables, the Table status line indicates the number of records. 
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4. If the screen is one of a Drives or Media screen pairing, the filter criteria are 
also applied to its partner. You can navigate to the partner screen to verify this. 
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The Applied Filter area of the tables on both screens indicate the same filter. 



Filtering Tasks

December 2012 Filtering Table Data  179

 

▼Clear the Current Filter 

Note – This procedure applies to both pivot and list view tables. 

Use this procedure to remove all filter criteria from a table. 

Note – To remove selected filter criteria from a table, see “Use the 
Filter Data Dialog Box to Change a Table Filter” on page 173. 

1. Click the Filter Data icon in the Table Toolbar. 

Note – This procedure uses a list view table, but you could also 
use a pivot table.
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The Filter Data dialog box appears, and all selection criteria currently in effect are 
indicated. 
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2. Click Reset.

The following updates are made to the table: 

• All filter criteria are removed from the table so it displays all available records.

• The Applied Filter area is blank, indicating no filter criteria are currently 
applied.

• For list view tables, the Table status line indicates the number of records 
displayed. 
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▼Use an Aggregate Count Link to Apply a Filter

Use this procedure to apply a filter by clicking an aggregate count link in an Analysis 
screen pivot table. The filter is applied to both the Analysis screen and to its 
“partner” Overview screen. 

1. Use the Navigation Bar to bring up an Analysis screen. 

The Media – Analysis screen is used in this example.   
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2. In the pivot table, click an aggregate count link. 

You are taken to the “partner” Overview screen (Media – Overview in this 
example), and the following updates are made to the list view table: 

• The table displays only the records included in the pivot table aggregate count. 

• The Applied Filter area indicates the filter criteria from the aggregate count. 

• The Table status line indicates the number of records displayed; this number is 
the same as the aggregate count in the pivot table. 
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3. Use the Navigation Bar to return to the Analysis screen.

The filter remains active; therefore, the Analysis screen displays only the records 
that meet the selection criteria intrinsic to the original aggregate count link.
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▼Apply a Filter From the Dashboard

Use this procedure to apply a filter by clicking a section of a bar or pie chart on the 
Dashboard. You are taken to the corresponding Overview screen, and the filter 
intrinsic to the bar or pie chart section is applied. This procedure allows you to 
display detail about data displayed on the Dashboard. 

1. Use the Navigation Bar to bring up the Dashboard. 

2. Click a section in a Dashboard bar or pie chart. 

You are taken to the corresponding Overview screen (Media – Overview in this 
example), and the following updates are made to the list view table: 

• The table displays only the records included in the selected Dashboard section. 

• The Applied Filter area indicates the filter criteria from the selected section.   
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• The Table status line indicates the number of records displayed; this number is 
the same as the Value for the selected Dashboard section. 

3. Use the Navigation Bar to select the “partner” Analysis screen, if applicable. 

Note – This step applies to Drive and Media Overview screens 
only. 
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The filter remains active; therefore, the Analysis screen displays only the records 
that meet the selection criteria intrinsic to the selected bar or pie chart section.
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7

Templates

Templates provide modified STA screen views that can be saved, re-used, and shared 
with other users. 

This section describes templates and provides instructions for their creation and use. 
The following topics are discussed:

• “Templates Overview” on page 190

• “Template Definition” on page 190

• “Templates Toolbar” on page 191

• “Template Types” on page 192

• “Pre-defined Template Summaries” on page 193

• “Template Tasks” on page 198
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Templates Overview
Templates include a variety of screen display characteristics, including graph and 
table layouts and filter criteria. Applying a template to a screen updates the screen 
display so it matches the characteristics defined in the template. See “Template 
Definition” for specifics.   

Templates are available for Overview and Analysis screens only. They are also screen-
specific; a template for the Drives – Overview screen can be applied to that screen 
only and cannot be applied to the Drives – Analysis screen, for example. 

Template Definition

Following are specific characteristics included and not included in the template 
definition.   

Screen Characteristics Included in the Template Definition

Graph display details, such as: • Wide vs. narrow view

• Graphed attributes

• Percent vs. actual value display

• Date range

Table display details, such as: • Hidden and visible columns 

• Column order

Filter criteria

Screen Characteristics Not Included in the Template Definition

• Table resource selections applied to graphs

• Table sort criteria

• Specific data content 
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Templates Toolbar 

The Templates Toolbar appears at the top of the main window area. It provides direct 
access to frequently used commands for applying and managing templates.

Icon Name Description

Help Displays help for template functions. 

Related Task: “Help”

Templates menu Menu lists all available templates for this screen. The first 
entry is always “Default”. The list includes pre-packaged 
templates and custom templates that are available to all 
users. Select a template to apply it to the current screen. 

Related Task: “Apply a Template”

Save Template Allows you to save the current screen configuration, either 
as a new template or as a modification of an existing 
template. 

Related Task: “Create a New Template” and “Modify a 
Template”

Delete Template Allows you to delete a template. 

Related Task: “Delete a Template”
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Template Types

STA provides a default template for each screen, as well as a set of pre-defined 
templates. You can also create your own custom templates, tailored to your needs.

Default Template

Each Overview and Analysis screen has a Default template, which is automatically 
applied whenever you navigate to the screen. To apply a different template, you 
simply select the template you want to use from the list in the Templates menu. If 
after applying a new template, you leave the screen and then return later, the Default 
template is applied again. 

Pre-defined Templates

STA is delivered with a set of pre-defined templates that provide you with frequently 
used information about library resources (libraries, drives, media) and events 
(exchanges, cleaning activities, and notifications). 

Pre-defined templates are available to all users. You can use them as is, or modify 
them and save the changes as custom templates. If you modify or delete a pre-
defined template, you can later restore the original. 

Custom Templates

Custom templates can be created by any STA user, and any number of custom 
templates can be created for each screen.

You create a custom template by applying modifications to the current screen—such 
as changing graphed attributes, re-ordering columns in a list view table, and/or 
applying filter criteria—and then saving the new display as a template. When you 
save a template you assign it a unique name and designate whether it is private or 
public, as follows:

• Public – Available to all STA users. 

• Private – Available only to the username under which it is saved. 

Once you have saved a custom template, it is immediately available for the current 
and future login sessions. Each user has access to all public templates as well as the 
private templates saved under their username. 
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Pre-defined Template Summaries
Following are short descriptions of the pre-defined templates for each Overview and 
Analysis screen. 

Libraries – Overview 

Libraries – Complexes Overview

Default Displays library properties and configuration information. 

STA-Lib-All Displays all library table attributes.

STA-Lib-Base-Information Displays the base library configuration and relatively static data; 
useful for library description and inventory listings.

STA-Lib-Configuration Displays library configuration and connection information; 
useful for troubleshooting connection issues. 

STA-Lib-Health Displays information about library health, firmware, and SNMP 
connection with STA. 

STA-Lib-Utilization Displays summary information about the amount and rates of 
library activity and drive utilization.

Default Displays library complex configuration. 

STA-Complex-All Displays all library complex graphs and table attributes. 

STA-Complex-Configuration Displays library complex configuration information.

STA-Complex-Utilization Displays information about the amount and rates of library 
complex activity and drive utilization. 
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Libraries – Exchanges

Drives – Overview

Default Displays identification and status information for the drive, 
media, and library involved in each exchange. 

STA-Exchange-Alerts-All Displays information about alerts that occurred during 
exchanges; exchanges that have not generated an alert are not 
included. 

STA-Exchange-Alerts-Errors Displays all exchanges that resulted in error-type alerts; alerts 
that are not errors, such as cleaning alerts, are not included. Your 
Oracle support representative may ask you to use this template 
prior to submitting error log information. 

STA-Exchange-Base Information Displays base information for all exchanges, such as drive and 
volume serial number, drive and media health, drive and media 
exchange status, MB read and written, and times. 

STA-Exchange-MIR-Alerts Displays all exchanges that resulted in alerts related to the media 
information record (MIR). Your Oracle support representative 
may ask you to use this template prior to submitting error log 
information.

Default Displays drive configuration information and the status of the 
most recent exchange that occurred on the drive. 

STA-Drive-All Displays all drive graphs and table attributes. 

STA-Drive-Base-Information Displays the base drive configuration and relatively static data; 
useful for drive description and inventory listings. 
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Drives – Analysis

Drives – Cleaning Activities

STA-Drive-Enterprise-Performance Displays summary performance data for enterprise drives only. 

STA-Drive-Health Displays current and summary health and activity information 
for all drives.

STA-Drive-LTO-Performance Displays performance data for LTO drives only. 

STA-Drive-LTO-Utilization Displays utilization statistics for LTO drives only. 

STA-Drive-Last-Exchange Displays information for the last exchange that occurred on each 
drive.

STA-Drive-Performance-30-Days Displays summary performance data for all drives over the last 
30 days. 

STA-Drive-Utilization Displays utilization statistics for all drives. 

Default Summarizes current drive health by library complex. 

STA-Drive-Firmware-Levels Summarizes current drive firmware levels by drive type.

STA-Drive-Read-Marginal Summarizes the “Exchange Read Marginal” status for applicable 
drives, by library complex name. Applicable to StorageTek 
T10000A and above drives only. 

Default Displays identification and status information for the drive, 
media, and library involved in each cleaning exchange.

STA-Cleaning-All Displays all cleaning exchange attributes.

STA-Cleaning-Base-Information Displays base information for all cleaning exchanges, such as 
drive and volume serial number, drive lifetime cleans, and 
current and maximum cleaning uses. 
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Media – Overview

Default Displays base information about the media, its most recent 
exchange, and the drive involved. 

STA-Media-All Displays all media graphs and table attributes.

STA- Media-Base-Information Displays the base media information and relatively static data; 
useful for media description and inventory listing.

STA-Media-Cleaning Displays base information about cleaning cartridges only. Also 
displays the status of the cleaning media’s most recent exchange 
and the drive involved. 

STA-Media-Expired Displays information about expired media. Your Oracle support 
representative may ask you to use this template prior to 
submitting error log information.   

STA-Media-Health Displays current and summary health and activity information 
for all media.

STA-Media-LTO-Performance Displays summary performance information for LTO media only. 

STA-Media-LTO-Utilization Displays summary utilization information for LTO media only. 

STA-Media-Last-Exchange Displays information about the last exchange for each piece of 
media.

STA-Media-MIR-Stats Displays data from the media information record (MIR). 

STA-Media-Stats-Last-Exchange Displays throughput and efficiency information for the last 
exchange for each piece of media. Your Oracle support 
representative may ask you to use this template prior to 
submitting error log information.

STA-Media-Utilization Displays summary utilization information for all media. 
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Media – Analysis

Notifications – Overview

Notifications – Analysis

Default Summarizes current media health by library complex.

STA-Media-HealthByMediaType Summarizes current media health by media type.

Default Displays SNMP traps, including detail about the library and 
device involved. 

STA-Notification-All Displays all attributes available for SNMP traps (no graphs are 
available for this screen).

STA- Notification-Base-
Information

Displays base data for SNMP traps; useful for an overview, 
description, and listing of notifications.

Default Summarizes notification severity levels by library complex. 
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Template Tasks

Task Page

Apply a Template 199

Create a New Template 201

Modify a Template 203

Delete a Template 206

Recover Pre-defined Templates 209
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▼Apply a Template

Use this procedure to apply a template to the current screen. When you initially bring 
up a screen, the Default template is always applied automatically. 

1. In the current screen, select the Templates menu.

The menu displays all templates for the current screen that are available to the 
current user. 
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2. In the Templates menu, select the template you want to apply.

The new template is applied.

Note – You can always verify the currently applied template by 
viewing the name displayed in the Templates field. 
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▼Create a New Template

Use this procedure to create and save a new template for the current screen. You can 
specify whether the template should be available for all users or just the current 
username. 

1. Apply the desired changes to the current screen.

Note – See “Template Definition” on page 190 for the types of 
screen changes that can be included in a template. 

In the following example, the Media – Overview screen has been modified by 
collapsing the graphics pane so that only the tables area is visible.
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2. When you have made all the modifications you want, click the Save Template 
icon. 

The Save Template dialog box appears.

3. Complete the Save Template dialog box, as follows:

a. In the Template Name field, type a new, unique name.

Note – If this entry is not unique, when you click Save, you will 
be asked to confirm whether you want to overwrite the existing 
template. 

a. In the Shared field, select an option:

• Private – The template will be available to the current user only.

• Public – The template will be available to all STA users. 

4. Click Save.

The template is saved and the name is displayed in the Templates menu.
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▼Modify a Template

Use this procedure to modify an existing template for the current screen. 

Note – If you modify a pre-defined template, you can later 
recover the original. See “Recover Pre-defined 
Templates” on page 209 for details. 

1. In the Templates menu, select the template you want to modify. 

The template is applied to the screen. 

2. Make the additional screen changes you want to include in the template. 

Note – See “Template Definition” on page 190 for the types of 
screen changes that can be included in a template. 

In this example, the screen is modified by applying the filter, “Media 
Type=TCLNU”. 
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3. Verify your changes, and then click Save Template in the Templates Toolbar. 

The Save Template dialog box appears, and the current template name is supplied 
in the Template Name field.

4. Complete the Save Template dialog box, as follows:

a. Leave the Template Name field as is. 

a. Depending on whether you want to modify the availability of the template, 
either select an option in the Shared field or leave the field as is:

• Private – The template will be available to the current user only.

• Public – The template will be available to all STA users. 

5. Click Save.

The Template Overwrite Confirmation dialog box appears.
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Note – This dialog box does not appear if it has been turned off. 
See “Modify Confirmation Dialog Box Preferences” on page 32 for 
details. 

6. Click Yes to confirm the modification.

The template is updated with the changes you have specified. 
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▼Delete a Template

Use this procedure to delete a template.

Note – If you delete a pre-defined template, you can later recover 
it. See “Recover Pre-defined Templates” on page 209 for details. 

1. Click Delete Template in the Templates Toolbar. 

The Delete Template dialog box appears.

2. In the Template Name menu, select the template you want to delete. 

3. Verify your selection, and then click Delete. 

The Delete Template confirmation dialog box appears.
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Note – This dialog box does not appear if it has been turned off. 
See “Modify Confirmation Dialog Box Preferences” on page 32 for 
details. 

4. Click Yes to confirm the deletion.

The template is deleted and is no longer displayed in the Templates menu. 
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Note – If the current screen was using the template you just 
deleted, then the screen is re-displayed using the Default 
template.
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▼Recover Pre-defined Templates

Use this procedure to recover pre-defined templates after modifying or deleting 
them. 

Note – This procedure does not affect custom templates you have 
created. 

Note – You will be required to log out of STA as part of this 
procedure. 

1. On any screen, select Preferences > Templates in the Main Toolbar. 

The template Reset dialog box appears. 
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2. Click Logout. 

You are logged out of STA and the Logged Out dialog box appears. 

3. Click Go to Login. 

The Login screen appears. 

4. Log in to STA. 

See “Log In to STA” on page 20 for details. 

When you log back in, all pre-defined templates are restored with their default 
settings. Any custom templates you have created are also available, as before. 
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8

Using STA to Answer
Tape Environment Questions

This chapter combines elements and procedures described in the previous chapters to 
address common questions about tape storage operations and health. The methods 
described are not exhaustive, but are meant as examples of some of the ways you can 
use STA to answer these and similar questions, and in the process build your 
expertise in using the STA product.

Each procedure includes a “Related Information” section, which refers to the 
elements and procedures from previous chapters. 

The questions are organized into the following categories:

• “Drive and Media Health Questions” on page 212

• “Capacity and Resource Management Questions” on page 243
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Drive and Media Health Questions 

Question Task

Which drive and media cartridge have had the 
most errors in the last 30 days? Is there any 
correlation between the two?

“Report the Media and Drive With the Most 
Errors” on page 213

Which drives have had the most errors this week? 
Have their error rates gone up?

“Report Trends in Drive Error Rates” on page 220

Which drives have had significantly declining 
efficiency over time?

“Report Drive Efficiency Trends” on page 227

Is the drive that failed twice today the same one 
that caused problems two months ago?

“Report Trends in Drive Failures” on page 231

At 9:00 am today, one of our tape jobs 
experienced an error. Which drive and media 
were involved? Have they also experienced other 
errors?

“Report Information to Help Troubleshoot Tape 
Job Errors” on page 233

What critical errors were reported to STA last 
month? Is the total number trending up, down, or 
staying stable?

“Report Trends in Critical Errors” on page 237



Drive and Media Health Questions

December 2012 Using STA to Answer Tape Environment Questions  213

 

▼Report the Media and Drive With the Most Errors

These procedures address the questions, “Which media cartridge and drive have had 
the most errors in the last 30 days? Is there any correlation between the two?” 

The following methods are described:

• “Report Drives With the Most Errors”, below

• “Report Media With the Most Errors” on page 215

• “Display Correlations Between the Two” on page 217

Referenced Tasks

• “Apply a Template” on page 199

• “Sort by a Column” on page 126

• “Add Library Resources to Graphs” on page 99

• “Use the Filter Data Dialog Box to Change a Table Filter” on page 173

▼ Report Drives With the Most Errors 

1. In the Navigation Bar, select Drives > Overview. 

2. In the Templates menu, apply the “STA-Drive-Health” template. 

3. In the “Drive Errors (30 Days)” column, click the Sort Descending arrow. 
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The drives with the most errors are brought to the top of the list.

4. Use the following steps to add selected drives to the graphs.

Adding the drives to the graphs allows you to compare their attribute values 
against the system average. By default, graphs always include the system average.

a. In the List View table, select the drives you want to add to the graphs. 

b. Click the Apply Selection icon on the Table Toolbar. 

The graphs are updated with the drive data. In the example below, one of the 
drives shows a high level of errors when compared with the system average. 
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▼ Report Media With the Most Errors 

1. In the Navigation Bar, select Media > Overview. 

2. In the Templates menu, apply the “STA-Media-Health” template. 
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3. In the “Dismounts With Errors (30 Days)” column, click the Sort Descending 
arrow. 

The media with the most errors are brought to the top of the list.

4. Use the following steps to add selected media to the graphs.

Adding the media to the graphs allows you to easily compare their attribute 
values against the system average. By default, graphs always include the system 
average.

a. In the List View table, select the media you want to add to the graphs. 

b. Click the Apply Selection icon on the Table Toolbar. 
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The graphs are updated with the media data. In the example below, both media 
show high numbers of errors when compared with the system average. 

▼ Display Correlations Between the Two

This procedure helps you to determine whether there are correlations between the 
drives and media with most errors. The Libraries – Exchanges screen is the most 
useful for this activity because each exchange involves exactly one drive and one 
piece of media. 

1. In the Navigation Bar, select Libraries > Exchanges. 
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2. Use the following steps to display only those exchanges that took place within 
the last 30 days and that involve the drive with the most errors.

The drive with the most errors was identified in “Report Drives With the Most 
Errors” on page 213. 

a. Click Filter Data.

b. Complete the Filter Data dialog box as follows:

• In the “Filter Matching” field, select “Match ALL entered criteria”. 

• In the “Exchange Start” field, select “Is After” and enter a date 30 days ago. 

• In the “Drive Serial Number” field, select “Is” and enter the serial number 
of the drive with the most errors. 

c. Click Apply. 
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The table is updated according to your selection criteria.   

3. To focus on the media involved in the errors, sort the table by a related column. 

Suggested columns are “Media Exchange Status”, “Exchange FSC”, or “Media 
Health Indicator”. 

4. Visually scan the Volume Serial Number field to see if there are any 
correlations between drive errors and specific media. 

5. If you do find a potential correlation, use the following steps to filter the data 
further to display just the exchanges that involve both the faulty drive and the 
suspect media. 

a. Click Filter Data.

The selection criteria already in effect are displayed in the Filter Data dialog 
box.

b. Complete the Filter Data dialog box as follows:

• Leave the current selection criteria as is.

• In the “Volume Serial Number” field, select “Is” and enter the volser of the 
suspect media identified in Step 4. 

c. Click Apply. 

The table is updated according to your selection criteria.   
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▼Report Trends in Drive Error Rates

This procedure addresses the questions, “Which drives have had the most errors this 
week? Have their error rates gone up?” 

Although STA screens show 30 days worth of data by default, you can use filter and 
selection criteria to narrow down to just the current week. The following methods are 
described:

• “Using the Drives – Overview Screen”, below

• “Using the Libraries – Exchanges Screen” on page 223 

• “Using the Notifications – Overview Screen” on page 225 

Referenced Tasks

• “Apply a Template” on page 199

• “Sort by a Column” on page 126

• “Add Library Resources to Graphs” on page 99

• “Change the Date Range” on page 94

• “Move a Column” on page 120

• “Hide and Reveal Columns” on page 131

• “Use the Filter Data Dialog Box to Change a Table Filter” on page 173

▼ Using the Drives – Overview Screen 

1. In the Navigation Bar, select Drives > Overview. 

2. In the Templates menu, apply the “STA-Drive-Health” template. 
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A running 30-day sum of drive errors is shown in the table and one of the graph 
panes. 

3. In the “Drive Errors (30 Days)” column, click the Sort Descending arrow. 

The drives with the most errors are brought to the top of the list.

4. Use the following steps to add the top five drives to the screen graphs.

a. In the List View table, select the top five drives. 

b. Click the Apply Selection icon on the List View Toolbar. 

All graphs, including “Drive Errors”, are updated to show these drives over a 
30-day period. 
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5. Use the following steps to narrow down the date range on the “Drive Errors” 
graph pane. 

a. Click the Choose Date Range icon on the “Drive Errors” Graph Pane 
Toolbar. 

b. Complete the Choose Date Range dialog box as follows:

• Select “Time Range”. 

• In the “Starting Date” and “Ending Date” fields, enter the start and end 
dates of the current week. 

c. Click OK. 
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The graph is updated according to your selection criteria. The variations in the 
graph lines show increases and decreases in error rates during the week.

▼ Using the Libraries – Exchanges Screen

1. In the Navigation Bar, select Libraries > Exchanges. 

2. In the Templates menu, apply the “STA-Exchange-Alerts-Errors” template. 

This template applies a filter to show only exchanges with errors. 
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3. In the “Drive Serial Number” column, click the Sort Ascending or Sort 
Descending arrow. 

Errors are grouped by drive, allowing you to bring focus to faulty drives. 

4. To focus on specific errors, use the following tasks to move columns around and 
remove empty columns, as applicable. 

• “Move a Column” on page 120

• “Hide and Reveal Columns” on page 131

5. Use the following steps to display just this week’s data.

a. Click Filter Data.

b. Complete the Filter Data dialog box as follows:

• In the “Filter Matching” field, select “Match ALL entered criteria”. 

• In the “Exchange Start” field, select “Is After” and enter a date one week 
ago. 

c. Click Apply. 
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The table is updated according to your selection criteria.   

▼ Using the Notifications – Overview Screen 

Since most notifications do not contain a specific drive reference, the information 
from this method is not as comprehensive as from the others. However, this 
method does provide a quick snapshot of drives whose health state has changed. 

1. In the Navigation Bar, select Notifications > Overview. 

2. In the “Device Serial Number” column, click the Sort Ascending or Sort 
Descending arrow. 

Errors and statuses are grouped by drive. 
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3. Visually scan the list for changes in the device state of individual drives. 
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▼Report Drive Efficiency Trends

This procedure addresses the question, “Which drives have had significantly 
declining efficiency over time?” 

STA records and displays many measures of data transfer rate efficiency, including 
read, write, and R/W combined rates. STA collects the rates per exchange and then 
summarizes them into daily and 30-day time periods. In addition, some drive types 
also provide their own efficiency calculations. Following are some of the efficiency 
attributes reported by STA. 

Referenced Tasks

• “Apply a Template” on page 199

• “Add a Graph Pane” on page 86

• “Change the Graphed Attribute” on page 92

• “Add Library Resources to Graphs” on page 99

1. In the Navigation Bar, select Drives > Overview. 

2. In the Templates menu, apply the “STA-Drive-Performance-30-Days” template. 

This template includes attributes related to drive performance. It does not include 
any graph panes. 
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Note – Some of the measures are null or zero if STA has not been 
monitoring a drive long enough to gather data and calculate 
accurate numerical values. 

3. Use the following steps to add graphs of interest to the Graph Area. 

By graphing selected attributes, you can see increases or decreases in efficiency 
over time, and compare individual drive efficiency numbers to the system 
average. 

a. Click the Restore Pane icon at the top of the screen to display the Graphics 
Area. 

The Graphics Area is blank. 

b. Click the Add Graph icon in the Graphics Area Toolbar. 

A new graph pane, with the attribute “MB Read”, is added to the Graphics 
Area display. 

c. Click the Change Graphed Attribute icon in the Graph Pane Toolbar, and 
select an attribute of interest. 
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d. Repeat Step b and Step c for any additional attributes you want to graph. 

The graphs are updated to display the system average for the attributes you 
have selected. The examples below show “Mount Read MB/sec”, “Mount 
Write MB/sec”, and “Mount R/W MB/sec”. 

4. Use the following steps to add the top five drives to the graphs.

Adding the drives to the graphs allows you to compare their attribute values 
against the system average. By default, graphs always include the system average.

a. In the List View table, select the top five drives. 

b. Click the Apply Selection icon on the Table Toolbar. 
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The drives are added to all the screen graphs. 
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▼Report Trends in Drive Failures

This procedure addresses the question, “Is the drive that failed twice today the same 
one that caused problems two months ago?” 

If the drive errors appear in the Notifications or Exchanges tables, you can filter the 
tables by drive ID and then look at current and historical data. The Exchanges table, 
in particular, allows you to select data for a specific time period. 

Referenced Tasks

• “Collapse and Restore the Graphics Area” on page 54

• “Use the Filter Data Dialog Box to Change a Table Filter” on page 173

1. In the Navigation Bar, select Libraries > Exchanges. 

2. To view more of the table data at once, click the Collapse Pane icon in the 
middle of the screen to expand the table vertically. 

3. Use the following steps to narrow down the data to exchanges that occurred 
between four and five months ago involving the suspect drive. 

a. Click Filter Data.

b. Complete the Filter Data dialog box as follows:

• In the “Filter Matching” field, select “Match ALL entered criteria”. 

• In the “Exchange Start” field, select “Is After” and enter a date three months 
ago. 

• In the “Drive Serial Number” field, select “Is” and enter the serial number 
of the drive with errors. 

• In the “Exchange End” date, select “Is Before” and enter a date two months 
ago. 

Note – If your site has exchanges that last more than a day, you 
may need to adjust your date settings to encompass complete 
exchanges involving the drive in question. 

c. Click Apply. 
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The table is updated according to your selection criteria. 

4. Visually scan the data to determine whether the drive experienced exchanges 
with errors during this period. 
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▼Report Information to Help Troubleshoot Tape Job Errors

This procedure addresses the questions, “At 9:00 am today, one of our tape jobs 
experienced an error. Which drive and media were involved? Have they also 
experienced other errors?” 

The following methods are described:

• “Using the Libraries – Exchanges Screen”, below

• “Using the Notifications – Overview Screen”

Referenced Tasks

• “Collapse and Restore the Graphics Area” on page 54

• “Use the Filter Data Dialog Box to Change a Table Filter” on page 173

• “Use Resource ID Links to Navigate” on page 58

▼ Using the Libraries – Exchanges Screen

In cases where each “job” is an independent exchange (that is, mount, read/write 
data, dismount), you can use this method to access information about tape job 
failures. 

1. In the Navigation Bar, select Libraries > Exchanges. 

2. So you can view more of the table data at once, click the Collapse Pane icon in 
the middle of the screen to expand the table vertically. 

3. Use the following steps to narrow down the data to just exchanges that 
experienced errors. 

a. Click Filter Data.

b. Complete the Filter Data dialog box as follows:

• In the “Filter Matching” field, select “Match ANY entered criteria”. 

• In the “Drive Exchange Status” field, select “Contains” and enter “ERROR”. 

• In the “Media Exchange Status” field, select “Contains” and enter 
“ERROR”. 
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Note – Entries are case-sensitive, so you must enter all upper-case 
characters. 

c. Click Apply. 

The table is updated according to your selection criteria. 

Note – The “Drive Health Indicator” and “Media Health 
Indicator” columns may indicate “Use” even after an error. This is 
because the values of these attributes are aggregated over time. 
The specific values depend on the frequency and severity of 
errors, and whether there have been subsequent exchanges with 
no problems. Recent exchanges with no problems move the 
aggregated value toward a “Use” status.

4. Scroll to exchanges that occurred around 9:00 am today, and review the 
information in the “Drive Exchange Status”, “Media Exchange Status”, and 
“Exchange FSC” columns for details about the errors.

By default, the rows of the table are sorted by “Exchange Start” time. 
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5. Optionally, to display detail about a drive or media cartridge involved in an 
error, select the text link in either the “Drive Serial Number” or “Volume Serial 
Number” column. 

 

▼ Using the Notifications – Overview Screen

In cases where you know the time of a job failure, you can use this method to check 
for related error notifications. 

1. In the Navigation Bar, select Notifications > Overview. 

1. In the Navigation Bar, select Notifications > Overview. 

2. Use the following steps to narrow down the data to just traps that involved 
errors. 

a. Click Filter Data.

b. In the “Severity” field, select “error”. 

c. Click Apply. 
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The table is updated according to your selection criteria. 

3. Scroll to traps that were received around 9:00 am today, and review the entries. 

By default, the rows of the table are sorted by “Date SNMP trap recv’d” time. 
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▼Report Trends in Critical Errors

This procedure addresses the questions, “What critical errors were reported to STA 
last month? Is the total number trending up, down, or staying stable?” 

STA reports instances of a wide variety of error types. This procedure provides 
instructions for exporting the error data to a spreadsheet application, which can then 
be used to summarize error trends over time. 

The following methods are described:

• “Using the Notifications – Overview Screen”, below

• “Using the Libraries – Exchanges Screen” on page 239

Referenced Tasks

• “Use the Filter Data Dialog Box to Change a Table Filter” on page 173

• “Move a Column” on page 120

• “Tooltips” on page 46

• “Change the Width of a Column” on page 123

• “Export Table Data to a Spreadsheet” on page 157

• “Apply a Template” on page 199

• “Collapse and Restore the Graphics Area” on page 54

• “Add a Graph Pane” on page 86

• “Change the Graphed Attribute” on page 92

▼ Using the Notifications – Overview Screen

1. In the Navigation Bar, select Notifications > Overview. 

2. Use the following steps to narrow down the data to traps sent within the last 
month. 

a. Click Filter Data.

b. Complete the Filter Data dialog box as follows:

• In the “Filter Matching” field, select “Match ALL entered criteria”. 
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• In the “Date SNMP trap archived” field select “Is After” and enter a date 
one month ago. 

• In the “Severity” field, select “error”. 

c. Click Apply. 

The table is updated according to your selection criteria. The “Severity” and 
“Text” columns are adjacent, allowing you to review them together. You may need 
to scroll to the right to see the columns. 

3. You can use any of the following methods to see the full error message text. 

• Move the mouse over the bottom border of the cell; the full text is displayed in 
a tooltip. 
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• Widen the “Text” column. 

• Export the table to a file. Then use a compatible spreadsheet application to 
open the file and format the error message text so it wraps within the table 
column.

▼ Using the Libraries – Exchanges Screen 

Drive and media errors are reported as a result of exchanges. Therefore, it is more 
efficient to look for errors on the Libraries – Exchanges screen, where drive and 
media data is consolidated, rather than on the Drives or Media screens.

1. In the Navigation Bar, select Libraries > Exchanges. 

2. In the Templates menu, apply the “STA-Exchanges-Errors-All” template 
(alternatively, apply the “STA-Exchanges-Alerts-Errors” template for a smaller 
subset). 

This template includes several columns that indicate different types of errors. The 
exchanges are sorted in reverse chronological order, — most recent exchanges 
first — allowing you to see at a glance which error types have predominated at 
your site over the last month. 
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3. If there are enough errors to indicate possible trends, use the following steps to 
add graphs of interest to the Graph Area. 

Attributes that may correlate to errors include “Write Efficiency”, “Read Margin”, 
and “R/W Rate MB/sec”.

a. Click the Restore Pane icon at the top of the screen to display the Graphics 
Area. 

The Graphics Area is blank. 

b. Click the Add Graph icon in the Graphics Area Toolbar. 

A new graph pane, with the attribute “Mount Read MB”, is added to the 
Graphics Area display. 

c. Click the Change Graphed Attribute icon in the Graph Pane Toolbar, and 
select an attribute you want to graph. 
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d. Repeat Step b and Step c for any additional attributes you want to graph. 

The graphs are updated to display the system average for the attributes you 
have selected. The examples below show “Write Efficiency”, “Read Margin”, 
and “R/W Rate MB/sec”. 

4. To calculate total errors by error type, you must use an external spreadsheet 
application. Use the following steps to export the data displayed in the table to 
an HTML-based Excel-compatible file. 

a. Click the Export icon in the Table Toolbar. 
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b. Save the file to a location on your local computer. 

c. Use a compatible spreadsheet application to open the file and summarize the 
data. 
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Capacity and Resource Management Questions

Question Task

How many libraries, drives, or media cartridges 
are in my tape system environment?

“Report Total Libraries, Drives, or Media” 
on page 244

How many drives or media cartridges of a 
particular type are in my tape system 
environment?

“Report Drive and Media Types” on page 247

Which are the top three drives in terms of 
utilization? 

“Report Drives With the Highest Utilization” 
on page 250

Which types of media are in short supply? Do I 
have an oversupply of any type?

“Report Shortages or Surpluses of Media” 
on page 253

Am I likely to need more media, drives, or 
storage cells next year? If so, how many?

“Project Future Media, Drive, or Storage Cell 
Requirements” on page 258

Which types of drives or media are used the most 
in my tape system?

“Report Resources With the Highest Utilization” 
on page 264

Which library in my tape environment is the 
busiest? Which is the least busy?

“Report Library Relative Activity Levels” 
on page 270

Which media cartridges are over 90 percent full? 
How do I generate a list that can be used to create 
a script to eject them from the library?

“Report Media Cartridges Approaching 
Capacity” on page 274

Have all my drives been upgraded to the latest 
firmware?

“Report Drive Firmware Levels” on page 276
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▼Report Total Libraries, Drives, or Media

These procedures address the question, “How many libraries, drives, or media 
cartridges are in my tape system environment?”

The following methods are described:

• “Using the Dashboard”, below

• “Using Overview Screens” on page 245

• “Using Analysis Screens” on page 246

Related Topics

• “Tooltips” on page 46

• “Clear the Current Filter” on page 179

▼ Using the Dashboard

1. In the Navigation Bar, select Dashboard.

2. If the number of resources (libraries, drives, or media cartridges) is small, you 
can do a quick visual count just by reading the graph. 

In the example below, you can estimate from the graph that there are eight 
libraries total: (1 + 1 + 6). 

3. If the number of resources is high, you can move the mouse over each slice in 
the pie chart to display tooltips of descriptive information, including totals.   

In the example below, the pie chart tooltips yield the count: 13 + 9 + 23 = 45 total.
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▼ Using Overview Screens 

In Overview screens, the total number of records displayed is listed at the lower-right 
corner of the List View table. As long as there are no filters applied, this number is 
the total of that type of resource (libraries, drives, or media) monitored by STA. 

1. In the Navigation Bar, select an Overview screen. 

2. Check the Applied Filter area of the table, and verify that there is no filter in 
effect. If one has been applied, see “Clear the Current Filter” on page 179 for 
instructions on clearing it. 

In the example below, no filter has been applied, and the Drives – Overview 
screen indicates there are 232 total drives monitored by STA. 
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▼ Using Analysis Screens 

Analysis screens aggregate data according to a variety of criteria. 

1. In the Navigation Bar, select an Analysis screen. 

2. Check the Applied Filter area of the table, and verify that there is no filter in 
effect. If one has been applied, see “Clear the Current Filter” on page 179 for 
instructions on clearing it. 

In the example of the Drives – Analysis screen below, no filter has been applied, 
and the pivot table breaks down the 232 total drives by library complex and state. 
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▼Report Drive and Media Types

These procedures address the question, “How many drives or media cartridges of a 
particular type are in my tape system environment?” 

The following methods are described:

• “Using the Dashboard”, below

• “Using Analysis Screens” on page 248

Referenced Tasks

• “Tooltips” on page 46

• “Use Resource ID Links to Navigate” on page 58

▼ Using the Dashboard

1. In the Navigation Bar, select Dashboard.

2. Move the mouse over the relevant section of a pie or bar chart to display a 
tooltip with descriptive information and totals. 

In the following example, moving the mouse over the T10000A bar chart reveals 
that there are a total of seven T10000A drives with a “Use” health. 
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3. If you select a section of a bar or pie chart, you are taken to the associated 
Overview screen, filtered for that type of drive or media. 

In the example below, the Drives – Overview screen is displayed, filtered to 
display only T10000A drives with a “Use” health. 

▼ Using Analysis Screens 

This method is especially useful if you want data aggregated by a series of criteria, 
such as by library and media state. The pivot table on Analysis screens presents this 
information in a concise format. 

1. In the Navigation Bar, select an Analysis screen (Drives – Analysis or Media – 
Analysis). 

In the example of the Media – Analysis screen below, subtotals and totals are 
provided at the bottom of each column and to the right of each row. 



Capacity and Resource Management Questions

December 2012 Using STA to Answer Tape Environment Questions  249

 



Capacity and Resource Management Questions

250  STA User Interface Guide December 2012 

 

▼Report Drives With the Highest Utilization 

These procedures address the question, “Which are the top three drives in terms of 
utilization?” 

Utilization can be defined in a number of ways, including lifetime hours in use, 
amount of data passed, and total number of mounts. The following methods are 
described:

• “Using Total Time in Motion”, below

• “Using Time in Use Over the Last 30 Days” on page 251 

Referenced Tasks

• “Apply a Template” on page 199

• “Sort by a Column” on page 126

▼ Using Total Time in Motion

Note – This information is provided only by StorageTek enterprise 
drives. 

1. In the Navigation Bar, select Drives > Overview. 

2. In the Templates menu, apply the “STA-Drive-Utilization” template. 

3. In the “Drive Lifetime Hours in Motion” column, click the Sort Descending 
arrow. 



Capacity and Resource Management Questions

December 2012 Using STA to Answer Tape Environment Questions  251

 

The top three drives in terms of time in motion are displayed at the top of the list.

▼ Using Time in Use Over the Last 30 Days

1. In the Navigation Bar, select Drives > Overview. 

2. In the Templates menu, apply the “STA-Drive-Utilization” template. 
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3. In the “% Drive Utilization (30 Days)” column, click the Sort Descending arrow. 

The top three drives in terms of percentage time in use are displayed at the top of 
the list.
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▼Report Shortages or Surpluses of Media

This procedure addresses the questions, “Which type of media am I the shortest on? 
Do I have an oversupply of any type?” 

The definition of media “available for writing” varies by site. For example, a site that 
does not re-use cartridges may simply compare total versus available capacity for 
each type of media; another site that does re-use cartridges may look at some “media 
life” measure instead. Both of these measures, and others, are available within STA. 
This procedure uses total versus available capacity. 

Referenced Tasks

• “Apply a Template” on page 199

• “Use the Filter Data Dialog Box to Change a Table Filter” on page 173

• “Sort by Multiple Columns” on page 128

• “Move a Column” on page 120

• “Export Table Data to a Spreadsheet” on page 157

1. In the Navigation Bar, select Media > Overview. 

2. In the Templates menu, select the “STA-Media-Utilization” template. 

This template includes all the attributes related to utilization, such as “Media 
Dismounts (30 Days)”, “MB Read (30 Days)”, and “Media Life Indicator”. 
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3. Use the following steps to eliminate any media for which capacity or 
availability information is not available. 

The longer STA monitors the libraries, the more exchange data it receives, and the 
lower the overall uncertainty level.

a. Click Filter Data.

b. In the “Media MB Capacity” field, select “Greater Than” and enter “0”. 

c. Click Apply. 

4. Note the number of records eliminated, since it reflects the level of uncertainty. 

In the example below, the number of records goes from 623 to 349, indicating a 
high uncertainty level. This library has been monitored for only a few days. 
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5. For the media in the resulting list, use the following steps to display the 
capacity and space available for each piece of media displayed. 

a. Select View > Sort > Advanced.

b. Complete the Advanced Sort dialog box as follows:

• In the “Sort By” menu, select “Media Type”.

• In the first “Then By” menu, select “Media MB Avail Pre”. 

• In the second “Then By” menu, select “Media MB Avail Post”. 

Note – LTO drives report “Media MB Avail Pre” and StorageTek 
enterprise drives report “Media MB Avail Post”. Sorting on both 
attributes allows you to capture all drive types. 

c. Click OK. 

The table is sorted according to your criteria.   

6. To better view the capacity data together on the screen, use the following steps 
to reorder the table columns. 

a. Select View > Reorder Columns.

b. In the Reorder Columns dialog box, arrange the following attributes so they 
are listed together.

• Media Type

• Media MB Capacity
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• Media MB Avail Pre

• Media MB Avail Post

c. Click OK. 

The table columns are reordered according to your criteria.   

7. To calculate the total capacity and space available for each media type, you must 
use an external spreadsheet application. Use the following steps to export the 
data displayed in the table to an HTML-based Excel-compatible file. 

a. Click the Export icon in the Table Toolbar. 

b. Save the file to a location on your local computer. 



Capacity and Resource Management Questions

December 2012 Using STA to Answer Tape Environment Questions  257

 

8. Use a compatible spreadsheet application to open the file and summarize the 
data. For example, you may want to calculate totals, percentages used, or 
averages by media type. 
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▼ Project Future Media, Drive, or Storage Cell Requirements

These procedures address the questions, “Am I likely to need more media, drives, or 
storage cells next year? If so, how many?” 

The criteria for determining whether drives or media need replacement varies by site. 

For drives, STA tracks many applicable criteria — in particular, several “drive 
lifetime” measures, such as Drive Lifetime Loads, Drive Lifetime Meters, and Drive 
Lifetime Power Hours. See “Report Percent Drive Utilization”, below, for one 
example. 

For media, STA provides data that is useful in a variety of scenarios, including the 
following: 

• Your site is migrating off one type of media and you need to replace it with 
another; see “Report Data Related to Media Migration” on page 261 for details. 

• Existing media are ageing or showing errors beyond your site-defined reasonable 
threshold; see “Report Data Related to Media Ageing” on page 263 for details. 

• Existing media are filling up; see “Report Shortages or Surpluses of Media” 
on page 253 for details. 

Referenced Tasks

• “Apply a Template” on page 199

• “Sort by a Column” on page 126

• “Use the Filter Data Dialog Box to Change a Table Filter” on page 173

• “Tooltips” on page 46

• “Create a New Template” on page 201

▼ Report Percent Drive Utilization 

1. In the Navigation Bar, select Drives > Overview. 

2. In the Templates menu, select the “STA-Drive-Utilization” template. 
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The first graph on the screen is “% Drive Utilization,” which displays the system 
average of percent drive utilization over time. This provides a high-level measure 
of activity for all drives in your environment.

3. To differentiate and compare the activity levels of individual drives, and to 
identify potential “hot spots,” you can sort or filter the drives in the table by 
various criteria, such as drive type or library. 

In the example below, the table is sorted in descending order of “% Drive 
Utilization (30 Days)” — highest percentage utilization first. 
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4. Use the following steps to add the top five drives to the screen graphs.

Adding the drives to the graphs allows you to compare their attribute values 
against the system average.

a. In the List View table, select the top five drives. 

b. Click the Apply Selection icon on the List View Toolbar. 

The drives are added to the graphs. 
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▼ Report Data Related to Media Migration

1. In the Navigation Bar, select Dashboard. 

The screen provides a high-level view of the number of media cartridges, 
aggregated by type.

2. Move the mouse over the “Library Media Cells” graph to display detail for each 
type of media stored in the library system. 
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The example below illustrates a site planning to migrate off older generation LTO2 
and LTO3 tapes. Moving the mouse over these two sections of the pie chart 
reveals there are a total of 27 LTO2 and 64 LTO3 tapes that must be replaced.

3. Select a section of the pie chart to go to the Media – Overview screen filtered 
for that type of media. 

The example below shows the screen filtered for LTO2 media. On this screen, you 
can organize the media records by remaining capacity, physical location, or other 
attributes pertinent to the migration process.

4. Alternative approaches for gathering this information are to use either of the 
following screens, which can summarize, filter, or aggregate media totals by 
type. 

• Media – Overview 

• Media – Analysis 



Capacity and Resource Management Questions

December 2012 Using STA to Answer Tape Environment Questions  263

 

▼ Report Data Related to Media Ageing

1. In the Navigation bar, select Media > Overview. 

2. In the Templates menu, select “STA-Media-Expired”. 

This template includes a filter and attributes related to media that have expired 
and should be retired from service. 
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▼Report Resources With the Highest Utilization

This procedure addresses the question, “Which types of drives or media are used the 
most in my tape system?” 

The drives and media that make up the majority of the system are not necessarily 
subject to the most use. Utilization is affected by your client configuration and the 
types of drives and media requested by these clients. This procedure addresses some 
of the most common ways of defining “most used”. 

The following methods are described:

• “Report Drive Utilization”, below

• “Report Media Utilization” on page 267 

Referenced Tasks

• “Apply a Template” on page 199

• “Use the Filter Data Dialog Box to Change a Table Filter” on page 173

• “Sort by Multiple Columns” on page 128

• “Export Table Data to a Spreadsheet” on page 157

▼ Report Drive Utilization

1. In the Navigation Bar, select Drives > Overview. 

2. In the Templates menu, apply the “STA-Drive-Utilization” template. 

This template displays utilization statistics for all drive types.
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3. Use the following steps to remove drives for which STA has no utilization data. 

a. Click Filter Data.

b. In the dialog box, locate the attribute that represents the utilization measure 
of interest to you. In the field menu, select “Greater than” and enter “0”. 

Following are some suggested attributes for measuring drive utilization.

• To identify drives with the highest utilization rates, use “% Utilization (30 
Days)”. 

• To identify drives that have recorded the most new data, use “MB Write (30 
Days)”, or “MB Received (30 Days)”. 

• To identify drives that have passed the most data at the drive head, use 
“MB R/W (30 Days)”. 

• For drives that have been in the library for their entire periods of use, the 
drive “lifetime” attributes are also useful measures of activity — for 
example, “Drive Lifetime Loads” or “Drive Lifetime Hours in Motion”. 

c. Click Apply. 

4. Perform a multiple-column sort to group the records by drive type and then 
utilization. 

a. Select View > Sort > Advanced.

b. Complete the Advanced Sort dialog box as follows:
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• In the “Sort By” field, select “Drive Type”.

• In the “Then By” field, select the attribute that you used in Step b above, 
and “Descending”. 

c. Click OK. 

The table is sorted according to your criteria. 

5. To summarize the data by drive type, you must use an external spreadsheet 
application. Use the following steps to export the data displayed in the table to 
an HTML-based Excel-compatible file. 

a. Click the Export icon in the Table Toolbar. 

b. Save the file to a location on your local computer. 

6. Use a compatible spreadsheet application to open the file and summarize the 
data. 
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▼ Report Media Utilization

1. In the Navigation Bar, select Media > Overview. 

2. In the Templates menu, apply the “STA-Media-Utilization” template. 

This template displays utilization statistics for all media types.

3. Use the following steps to remove media for which STA has no utilization data. 

a. Click Filter Data.

b. In the dialog box, locate the attribute that represents the utilization measure 
of interest to you. In the field menu, select “Greater than” and enter “0”. 

Following are some suggested attributes for measuring media utilization: 

• To identify media with the greatest amount of movement, use “Time spent 
reading or writing”.

• To identify media below a specific threshold of available space, use “Media 
MB Avail Pre/Post”

• To identify media with the greatest number of mounts and dismounts, use 
“Media Dismounts (30 days)”. 

• To identify media with the greatest amount of data read or written, use “MB 
R/W (30 days)”. 

c. Click Apply. 
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4. Perform a multiple-column sort to group the records by media type and then 
utilization. 

a. Select View > Sort > Advanced.

b. Complete the Advanced Sort dialog box as follows:

• In the “Sort By” field, select “Media Type”.

• In the “Then By” field, select the attribute that you used in Step b above, 
and “Descending”. 

c. Click OK. 
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The table is sorted according to your criteria. 

5. To summarize the data by media type, you must use an external spreadsheet 
application. Use the following steps to export the data displayed in the table to 
an HTML-based Excel-compatible file. 

a. Click the Export icon in the Table Toolbar. 

b. Save the file to a location on your local computer. 

6. Use a compatible spreadsheet application to open the file and summarize the 
data. 
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▼Report Library Relative Activity Levels

This procedure addresses the questions, “Which library in my tape environment is 
the busiest? Which is the least busy?” 

The definition of “busy” varies by site; common definitions include the number of 
exchanges, mounts, or dismounts. This procedure uses the number of mounts. In 
addition, it provides instructions for graphing the data so you can compare the 
libraries to one another and to the system average.

Referenced Tasks

• “Apply a Template” on page 199

• “Sort by a Column” on page 126

• “Add a Graph Pane” on page 86

• “Change the Graphed Attribute” on page 92

• “Add Library Resources to Graphs” on page 99

• “Detach a Graph Pane” on page 82

1. In the Navigation Bar, select Libraries > Overview. 

2. In the Templates menu, apply the “STA-Lib-Utilization” template. 

3. In the “Mounts (30 Days)” column, click the Sort Ascending or Sort Descending 
arrow. 

Note – Other columns you might want to sort by are “Enters 
(30 Days)”, “Ejects (30 Days)”, “Occupied Storage Cells”, or 
“MB R/W (30 Days)”.   
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4. Use the following steps to add a graph pane showing mounts.

a. Click the Add Graph icon in the Graphics Area Toolbar. 

A new graph pane, with the attribute “MB Read”, is added to the end of the 
Graphics Area display. You may need to scroll down to see the graph. 

b. Click the Change Graphed Attribute icon in the Graph Pane Toolbar, and 
select the “Mounts” attribute from the menu. 

The graph is updated to display the system average for mount data. 
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5. Use the following steps to add selected libraries to the screen graphs.

Adding the libraries to the graphs allows you to compare their attribute values 
against the system average.

a. In the List View table, select the libraries you want to add to the graphs. 

b. Click the Apply Selection icon on the List View Toolbar. 

In the example below, the three libraries with most mounts are added to all the 
graphs. 
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6. In the “Mounts” graph pane, click the Detach icon to detach the graph to 
enlarge it and display more detail. 
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▼Report Media Cartridges Approaching Capacity

This procedure addresses the questions, “Which media cartridges are over 90 percent 
full? How do I generate a list that can be used to create a script to eject them from the 
library?” 

STA reports cartridge capacity and available space as numerical values only, not as 
percentages. This procedure provides instructions for exporting the numerical values 
to a spreadsheet application, which can then be used to calculate percentages. The 
resulting list can be used by a cartridge eject script. 

Referenced Tasks

• “Apply a Template” on page 199

• “Sort by a Column” on page 126

• “Export Table Data to a Spreadsheet” on page 157

1. In the Navigation Bar, select Media > Overview. 

2. In the Templates menu, apply the “STA-Media-Utilization” template. 

This template includes the “Media MB Available” and “Media MB Capacity” 
attributes. 

3. In the “Media MB Capacity” column, click the Sort Descending arrow. 
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The cartridges with the highest capacity are brought to the top of the list. This sort 
also has the advantage of grouping cartridges by media type, since capacity tends 
to vary by media type. 

4. To create a list that can be used by a cartridge eject script, you must use an 
external spreadsheet application. Use the following steps to export the data 
displayed in the table to an HTML-based Excel-compatible file. 

a. Click the Export icon in the Table Toolbar. 

b. Save the file to a location on your local computer. 

5. Using a compatible spreadsheet program, add a “Percentage Full” column, 
containing calculated values derived from the attributes in the exported table. 
Sort the table by the column values and identify a list of cartridges over 90 
percent full. 
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▼Report Drive Firmware Levels

This procedure addresses the question, “Have all my drives been upgraded to the 
latest firmware?” Firmware levels are usually evaluated by drive type or model.

The following methods are described:

• “Using the Drives – Overview Screen”, below

• “Using the Drives – Analysis Screen” on page 279

Referenced Tasks

• “Apply a Template” on page 199

• “Move a Column” on page 120

• “Sort by Multiple Columns” on page 128

• “Use the Filter Data Dialog Box to Change a Table Filter” on page 173

• “Change Table Attributes and Their Nesting Order” on page 154

• “Use Aggregate Count Links to Navigate” on page 61

▼ Using the Drives – Overview Screen 

1. In the Navigation Bar, select Drives > Overview. 

2. In the Templates menu, apply the “STA-Drives-Base-Information” template.

This template includes the drive firmware version and other related attributes. 
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3. Use the following steps to reorder the table columns so the drive firmware level 
is displayed next to the drive model.

a. Select View > Reorder Columns.

b. In the Reorder Columns dialog box, arrange the following attributes so they 
are listed together.

• Drive Model

• Drive Firmware Version

c. Click OK. 

The table columns are reordered according to your criteria.   



Capacity and Resource Management Questions

278  STA User Interface Guide December 2012 

 

4. To display firmware levels by drive type, use the following steps to set up a 
multiple-column sort. 

a. Select View > Sort > Advanced in the Table Toolbar. 

b. Complete the Advanced Sort dialog box as follows:

• In the “Sort By” field, select “Drive Model”.

• In the “Then By” field, select “Drive Firmware Version” and select 
“Descending”. 

c. Click OK. 

The table is sorted according to your criteria.   

5. Use the following steps to display firmware levels for a specific drive model. 

a. Click Filter Data. 

b. In the “Drive Model” field, select the drive model of interest. 

c. Click Apply. 



Capacity and Resource Management Questions

December 2012 Using STA to Answer Tape Environment Questions  279

 

The table is updated according to your selection criteria. 

▼ Using the Drives – Analysis Screen 

This method provides totals by drive and firmware level, and aggregates the totals by 
library complex. 

1. In the Navigation Bar, select Drives > Analysis. 



Capacity and Resource Management Questions

280  STA User Interface Guide December 2012 

 

2. Use the following steps to display firmware levels for a specific drive model. 

a. Click Filter Data. 

b. In the “Drive Model” field, select the drive model of interest. 

c. Click Apply. 

The table is updated according to your selection criteria. 
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3. Use the following steps to reorganize the pivot table to aggregate firmware 
levels by drive model.

a. Click the Change Attribute icon on the Pivot Table Toolbar. 

b. In the Change Attributes dialog box, rearrange the attributes so the 
“Selected Attributes” list is as follows:

• Drive Model 

• Drive Firmware Version

• Library Complex Name

Note – The last attribute in the list — in this case, “Library 
Complex Name” — always designates the column headers. The 
remaining attributes designate the row layers, nested in the order 
listed — in this case, “Drive Firmware Version” within “Drive 
Model”. 

c. Click OK. 

The pivot table is updated according to your criteria. 
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4. To display a detailed listing of any of the subtotals, click the text link in a cell.

You are taken to the Drives – Overview screen, which displays additional detail 
for the drives included in the selected subtotal. 
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